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1 Foreword
The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient functions for efficient
project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

The Drive Based Synchronous application contained in the software provides universal solutions for drive-based motion
control using position, velocity and torque/force control types. The motion commands associated with these control types
are categorized into the following operating modes:

= Command
= Motion block

The Drive Based Synchronous application enables you to operate axes in synchronous operation, e.g. to use a virtual master
in order to move several axes on a platform equally or to use a master encoder in order to synchronize axes with an
upstream machine, such as when using conveyor belts.

Additional functions for monitoring process variables such as positions or velocities offer added convenience in monitoring.

This documentation describes the general functions of the Drive Based Synchronous application and guides you step by
step through the setup and project configuration of your drive project in the individual operating modes.

1 | Foreword
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2 User information

This documentation supports you in the setup and project configuration of your drive system with the Drive Based
Synchronous application in conjunction with Drive Based device control.

Technical knowledge

To be able to commission one or more drive controllers using the Drive Based Synchronous application, possibly in
combination with a controller, you should have basic knowledge of handling 6th generation STOBER drive controllers and of
the DriveControlSuite commissioning software.

Technical requirements

Before you begin operating your drive system, you need to have wired the drive controllers involved and initially check that
they are functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer

As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product

This documentation is mandatory for SB6 series drive controllers in conjunction with the DriveControlSuite software (DS6)
inV 6.7-A or later and associated firmware in V 6.7-A or later.

2.3 Directives and standards

Refer to the drive controller documentation for the European directives and standards relevant to the drive controller and

accessories.

2.4 Timeliness

Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.5 Original language

The original language of this documentation is German; all other language versions are derived from the original language.

2.6 Limitation of liability

This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

10/2025 | ID 443501.00
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2.7 Formatting conventions

Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.71 Display of warning messages and information

Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

= if the stated precautionary measures are not taken.

/A CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

= if the stated precautionary measures are not taken.

/A WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

2 | User information

A DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.72 Markup of text elements

Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning
Interpolated position mode Optional: File or product name or other name
Detailed information Internal cross-reference
http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu Window names, dialog box names, page names or buttons, combined
Settings proper nouns, functions referenced by the interface
Select Predefined entry

Referencing method A

Save your User-defined entry
<own IP address>

EVENT 52: Displays (status, messages, warnings, faults)
COMMUNICATION

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

Operating buttons

The buttons of the drive controller are depicted as follows in the continuous text.

[OK] Button on the operating unit of the drive controller

2.7.3 Mathematics and formulas

The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition
X Multiplication
+ Division

| Absolute value

10/2025 | ID 443501.00
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2.8 Trademarks

The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen’, CANopen® and CiA’ are registered trademarks of CAN in AUTOMATION e.V.,
CiA® Germany, the international user and manufacturer association.

EnDat’ EnDat” and the EnDat’ logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Germany.

EtherCAT', EtherCAT" and TwinCAT are registered trademarks and patented technologies,
Safety over EtherCAT’ licensed by Beckhoff Automation GmbH, Germany.

PLCopen’ PLCopen’ is a registered trademark of the PLCopen Organisation, Netherlands.
PROFIBUS’, PROFIBUS’ and PROFINET" are registered trademarks of PROFIBUS

PROFINET" Nutzerorganisation e.V., Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.




3 | Safety notes STOBER

3 Safety notes

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

= Observe the safety notes in the drive controller documentation.

= Consider the residual risks in the risk assessment for the machine or system.

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

= Observe the security notes in the drive controller documentation.
= Protect the parameterization, e.g. from unauthorized access.

= Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).

10
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4 What you should know before commissioning

The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

4.1 DS6 program interface

Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

11
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Fig. 1: DS6: Program interface

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in

the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter You can use variable parameter lists to compile any parameters in individual parameter
lists lists for a quick overview.
9 Status bar In the status bar, you can find the specifications of the software version and get additional

information about the project file, the devices and the progress of the process during
processes such as loading projects.

12
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411 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

- Reset Resets the view to factory settings.
EEE Project Shows/hides the Project window (project tree, project
menu).
e Messages Shows/hides the Messages window.
V{ Parameter check Shows/hides the Parameter check window.
' Variable parameter lists Shows/hides the Variable parameter lists window.

e

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.

13
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41.2 Navigation using sensitive circuit diagrams

Axis model

LIETypo efasks | D: Liser cafined, ratatiensl |
e
Lo Motor encoder [Zid4eocnder 7|

L1032 Pastton sncocer | 0t Motor encader -

LM range (DLl =1

Rtmborw, lmitert moersert

Scaling axis

Motor

®
®

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to graphically illustrate the processing sequence of actual and set values, the use of signals or the arrangement of

drive components and to make configuring the accompanying parameters easier, they are displayed on the respective
wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a

result, allow you to reach additional helpful detail pages with a click.

14
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4.2 Meaning of parameters

You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a

coordinate or the combination of coordinate and name.

E50| Drive controller | G6 | \[1)
| | |

Coordinate Name Version

Drive controller
generation/series

4.21 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.
A Drive controllers, communication, cycle times
B Motor
C Machine, velocity, torque/force, comparators
D Set value
E Display
F Terminals, analog and digital inputs and outputs, brake
G Technology — Part 1 (application-dependent)
H Encoder
| Motion (all motion settings)
J Motion blocks
K Control panel
L Technology — Part 2 (application-dependent)
M Profiles (application-dependent)
N Additional functions (application-dependent; e.g. extended cam control unit)
P Customer-specific parameters (programming)
Q Customer-specific parameters, instance-dependent (programming)
R Production data for the drive controller, motor, brakes, motor adapter, gearbox and geared motor
S Safety (safety technology)
T Scope
V] Protection functions
z Fault counter

Tab. 1: Parameter groups

15
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4.2.2 Parameter types and data types

In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,

data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed)
INT16 Integer 2 bytes (1 word, signed)
INT32 Integer or position 4 bytes (1 double word,
signed)
BOOL Binary number 1 bit (internal:
LSBin 1 byte)
BYTE Binary number 1 byte (unsigned)
WORD Binary number 2 bytes (1 word, unsigned)
DWORD Binary number or 4 bytes (1 double word,
parameter address unsigned)
REAL32 Floating-point number 4 bytes (1 double word,
(single type according to signed)
IEE754)
STR8 Text 8 characters
STR16 Text 16 characters
STR80 Text 80 characters

Tab. 2: Parameters: Data types, parameter types, possible values

Parameter types: Use

Integer, floating-point number
For general computing processes

Example: Set and actual values

Selection
Numeric value to which a direct meaning is assigned

Example: Sources for signals or set values

Binary number
Bit-oriented parameter information that is collected in binary

Example: Control and status words

Position
Integer combined with associated units and decimal places

Example: Actual and set values of positions

Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units

Example: Actual and set values for velocity, acceleration, deceleration, jerk

Parameter address

Referencing of a parameter

-128-127
-32768 — 32767
-2 147 483 648 —2 147 483 647

0,1
0-255
0-65535

0-4294967 295

-3.40282 x 10* - 3.40282 x 10*

Example: In F40 AO1 source, for example, EO8 n-motor filtered can be parameterized

Text

Outputs or messages
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4.2.3 Parameter types

The following types of parameters are differentiated.

Simple parameters

Array parameters

Consist of one group and one line with a A21 Brake resistor R: Value = 100 ohms
defined value.

Consist of a group, a line and multiple A10 Access level
sequential (listed) elements, which have the

same properties but different values. = A10[0] access level: Value = Access level

via operating unit

= A10[2] access level: Value = Access level
via CANopen and EtherCAT

= A10[4] access level: Value = Access level

via PROFINET

Record parameters Consist of a group, a line and multiple A0O Save values
sequential (listed) elements, which can have
different properties and different values.

= AOQ0[1] Progress: Value = Display action

progress

= A00[2] Result: Value = Display action

result

Tab. 3: Parameter types

4.2.4 Parameter structure

Every parameter has specific coordinates with the following structure.

1. E250(2] .3
T

Line
Group  Element
Axis Bit
= Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters
(value range: 1—4).

= Group
The thematic group to which a parameter belongs (value range: A —Z).
= Line
Distinguishes the parameters within a parameter group (value range: 0 — 999).
= Element (optional)
Elements of an array or record parameter (value range: 0 — 16000).
= Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 — 31).

= AQ0[O] Start: Value = Start action
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4.2.5 Parameter visibility

The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

= Level 0

Elementary parameters

= Levell

Important parameters of an application

= Level 2

Important parameters for service with extensive diagnostic options

= Level 3

All parameters needed for commissioning and optimizing an application
The parameter A10 Access level controls general access to parameters:
= Qver the drive controller display (A10[0])
= Over CANopen or EtherCAT (A10([2])

= Over PROFINET (A10[3])

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

For example, a drive controller can evaluate an encoder using terminal X120, provided that a corresponding terminal
module has been installed. The accompanying evaluation is activated using parameter H120. However, this parameter is
visible only if the terminal module was initially selected during the drive project configuration.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.
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Information

If a parameter exists in the configuration due to the projected properties of the drive controller (e.g. hardware, firmware,
application), it is generally available for fieldbus communication. The visibility of a generally available parameter has no
effect on its availability for fieldbus communication (e.g. through access level or parameter selection).

4.3 Signal sources

Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a fieldbus system and
terminals. You can use the corresponding selection parameters, referred to as signal sources, to configure in
DriveControlSuite whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as the source. In case of
activation by fieldbus, parameters are selected as sources for control signals and set values, which must be part of the
process data mapping between the controller and drive controller so that the controller can write to them via fieldbus.

4.4 Non-volatile memory

All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller
To save the configuration in non-volatile memory on a drive controller, you have the following options:

= Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard:
Select the Save values action

= Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > AOO Save values:
Set the parameter A0OO[0] to the value 1: Active

= Saving the configuration using the S1 operating button:
Press and hold the operating button for 3 s

= Saving the configuration using the operating unit:
Press the save button for 3 s

Saving to all drive controllers within a project
To save the configuration in non-volatile memory on several drive controllers, you have the following options:

= Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

= Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with the last correct configuration that was saved and with fault 40: Invalid data the next time it is
switched on. In order to acknowledge the fault and successfully complete the saving process, the configuration must be
stored again in non-volatile memory and the action must be completed.
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5 Commissioning

The following chapters describe how to commission your drive system using DriveControlSuite.

For the components of your axis model, we assume one of the following two combinations as an example:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

Synchronous servo motors are saved along with all relevant data for the project configuration in the DriveControlSuite
motor database and in the electronic nameplate. When the motor is selected from the database, as well as when the
nameplate is read out, all data is transferred to the corresponding parameters. There is no need for complex
parameterization of the motor, encoder and brake.

LM Lean motor without encoder (with optional brake)

Lean motors are stored in the motor database of the DriveControlSuite, along with all the data relevant for project
configuration. Furthermore, the motor data and the release and engaging times of the brake are part of the firmware.
When the motor is selected from the database, all data is transmitted to the corresponding parameters. There is no need
for time-consuming parameterization of the motor and brake. For optimum operation of the Lean motor, it is only
necessary to parameterize the cable length and the mass inertia ratio of the load to the motor and, if necessary, activate
the brake.

For asynchronous motors, the motor data relevant for project configuration is also taken from the motor database. All
other motor types need to have their parameters configured manually.

Before you begin commissioning, make sure that the system nodes are hooked up and supplied with control voltage.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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5.1 Initiating the project

In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

511 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project
1. Start DriveControlSuite.
2. Onthe start screen, click Create new project.

= The new project is created and the configuration dialog for the first drive controller opens.

= The Drive controller button is active.

Projecting the drive controller

1. Properties tab:

Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:

Define the reference code (equipment code) of the drive controller.

1.2. Designation:

Give the drive controller a unique name.

1.3. Version:

Version your project configuration.

1.4. Description:

If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:

Select the series, device type and firmware version of the drive controller.

3. Option modules tab:

Project the option modules of the drive controller.

3.1. Terminal module:
If you are controlling the drive controller via analog and digital inputs, select the corresponding terminal

module.

3.2. Safety module:

If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:

Project the basic control of the drive controller.

4.1. Device control:

Select device control Drive Based.

4.2. Rxprocess data, Tx process data:

If you use a fieldbus to control the drive controller, select the corresponding receive and transmit process data.
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Projecting the axis

1. Click Axis A.

2. Properties tab:
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the axis.

2.2. Designation:

Give the axis a unique name.

2.3. Version:

Version your project configuration.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Application tab:

Select the Drive Based Synchronous application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter

the accompanying motor data later.

5. Confirm with OK.

512 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (see Further information [P 156]).

51.3 Creating other drive controllers and modules

In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a new drive controller to
your project, be sure to always assign it to an existing module. Group drive controllers in a module if, for example, they are
located in the same control cabinet or work together to operate the same machine part.

Creating a drive controller
1. Inthe project tree, select your project P1 > module M1 > context menu Create new drive controller.
= The drive controller is created in the project tree and the configuration dialog opens.

2. Project the drive controller as described in Projecting the drive controller and axis [P 21].

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module
1. Inthe project tree, select your project P1 > context menu Create new module.

= The module is created in the project tree.

2. Project the module as described in Projecting the module [» 23].

3. Repeat the steps for all other modules that you want to project.
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514 Projecting the module

Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

= The configuration dialog for the module opens.
2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the module.

2.2. Designation:

Give the module a unique name.

2.3. Version:

Version the module.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

515 Projecting the project

Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.
= The configuration dialog for the project opens.
2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the project.

2.2. Designation:

Give the project a unique name.

2.3. Version:

Version the project.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.2 Mapping the mechanical axis model

To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

5.2.1 Parameterizing the motor

You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. All additional data
on the brake and encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. You only have to
parameterize the cable length in use and the mass inertia ratio of the load to the motor. Even the brake purging and
engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Motor wizard.

3. B101 Cable length:

Select the cable length of the power cable in use.
4. Select the Control cascade wizard > Control mode.

5. (30 J-Last / J-Motor:
Parameterize the mass inertia ratio of the load to the motor.

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard

area.
2. Select the Brake wizard.

3. FOO Brake:
Select 1: Active.
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52.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:
= Define the axis model
= Scale the axis
= Parameterize the position and velocity window
= Limit the axis (optional)
e Limit the position
e Limit the velocity, acceleration and jerk

e Limit the torque and force

5.2.2.1 Define the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. 105 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined,
translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying positions, velocities,
accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:

Select the interface to which the motor encoder is connected.

5. 102 Position encoder (optional):

Select the interface to which the position encoder is connected.
6. 100 Position range:
Select whether the travel range of the axis is limited or endless (modulo).

Information

When you parameterize 105 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (109)
and the decimal places (106) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s?, jerk in rad/s>.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s?, jerk in m/s>.

Information

If you do not parameterize it differently for 102 Position encoder, B26 Motor encoder is used for position control as
standard.
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5222 Scale the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,

accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. 101 Circular length:

If you have selected 1: Endless = 100 Position range, define the revolution length.

5. 106 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for 105 Type of axis, define the desired

number of decimal places.

6. 109 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for 105 Type of axis, define the desired

unit of measure.

7. 103 Axis polarity:

Use the polarity to define the direction of interpretation between the axis movement and motor movement.

Information

A change to parameter 106 moves the decimal separator for all axis-specific position values! Ideally, define 106 before
parameterizing other position values and then check them.

If the axis receives set value specifications from a controller or follows the master values of a master, the resolution of
position values directly impacts the smooth operation of the axis. Therefore, you should define a sufficient number of
decimal places appropriate for your application.

Information

Parameter 1297 Maximum speed position encoder must be parameterized according to your application case. If 1297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if 1297 is set too
high, measuring errors of the encoder can be overlooked.

1297 depends on the following parameters: 105 Type of axis, |06 Decimal places position, 109 Measure unit as well as
107 Distance factor numerator position and 108 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select 1297 accordingly as well.
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52.2.3 Parameterizing the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:

Parameterize a tolerance window for velocity tests.

3. 122 Target window:

Parameterize a tolerance window for position tests.

4. 187 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. 121 Maximal following error:

Parameterize a tolerance window for lag tests.

For more information on monitoring the lag, see Lag monitoring [» 153].
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5224 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gearbox output
and axis in order to convert the values to all other locations in the axis model.

Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using a software or hardware
limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Axis model wizard > Limit: Position.

3. 1101 Source positive /limit switch, 1102 Source negative /limit switch:
To limit the travel range of the axis in the positive or negative direction of motion via hardware limit switches, select

the source of the digital signal that is used to evaluate a limit switch at the positive or negative end of the travel range.
3.1. If bit 1 or bit 2 of the control word 1210 of the application is the source, select 2: Parameter.
3.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

4. 150 Software stop positive, 151 Software stop negative:
If you selected 0: Limited for 100 and would like to limit the travel range of the axis via software limit switches, define

the largest or smallest permitted position for software position limiting.

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

= Allow sufficient space past the limit switch for your application to bring the axis to a standstill.
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Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration

according to your application. The default values are designed for slow velocities without gearboxes.

1.

2.

Select the Motor wizard.

B83 v-max motor:

Determine the maximum permitted velocity of the motor.
Select the Axis model wizard > Axis: Scaling.

Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the motor and the maximum permitted
velocity of the output as a reference value.

Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

110 Maximal speed:
Define the maximum permitted velocity of the output according to your application (taking into account the
previously determined reference value).

111 Maximal acceleration:

Define the maximum permitted acceleration for the output.

116 Maximal jerk:
Define the maximum permitted jerk for the output.

117 Quickstop deceleration:

Define the desired quick stop deceleration for the output.

Limiting the torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated

operation together with the overload reserves.

1.

2.

Select the Axis model wizard > Limit: Torque/force.

C03 Maximum positive torque/force, CO5 Maximum negative torque/force:

Define the maximum permitted set torque/maximum permitted set force.

C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-
controlled emergency stop SS1, SS1 and SS2.
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53 Referencing absolute position

When commissioning a system with position measurement systems, the relation of a measured to an actual axis position
must be determined to be able to work with absolute positions.

If you are working with absolute positions, reference the axis now. Otherwise, proceed by parameterizing application-
specific conditions and responses of the Drive Based device control.

/A WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

= Only execute this function if there are no slave axes coupled with the master.

5.31 Defining the referencing method

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Referencing wizard.

3. 130 Referencing type, 131 Referencing direction, 135 Referencing with zero pulse:
Define the characteristics for referencing.
For information on possible combinations of the named characteristics as well as detailed descriptions of the

individual referencing methods, see Referencing methods [P 115].

4. 143 Move to reference position:

If the axis is to automatically move to the referenced position after referencing, set this parameter to 1: Active.

53.2 Parameterizing the reference switch

If you are working with absolute positions and would like to determine a reference position while referencing using the
reference switch, proceed as follows.

1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.
2. 1103 Source reference switch:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 3 of the control word 1210 of the application is the source, select 2: Parameter.

533 Setting the reference

If you are working with absolute positions and would like to reference without using a referencing run, the value of the
current actual position is applied directly as a parameter value from 134 using the Set reference signal.

1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.
2. 1111 Source set reference:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 11 of the control word 1210 of the Drive Based Synchronous application is the signal source, select 2:

Parameter.
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54

Parameterizing Drive Based device control

The Drive Based device control describes the control sequence of a drive controller based on a state machine, i.e. a drive

controller switches its state due to an event. Some of the conditions and responses coupled with the state transitions can

be influenced depending on the application; for example, it is possible to define the end of a quick stop or enable signal

delays tailored to the respective application case.

For more information on the device control and Drive Based device state machine, see Drive Based device control [P 142].

5.41 Parameterizing transition conditions

v’ You have projected a drive controller with the Drive Based device control.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based device control wizard.

3. A34 Auto start:
If the drive controller is to switch directly to the Operation enabled state after the Switch on disabled state, activate
this parameter.

4. A43 Enable switch-on/off delay
If you need to hide possible fault or test pulses on the enable input, enter the maximum internal activation and
deactivation delay.

5. A44 Quick stop at enable off:
If the axis is to be stopped with a quick stop in the event of an Enable-off, activate this parameter.

6. A60 Source additional enable:
If you are working with multiple enable signals, select the source of additional signals in this parameter.

7. A29 Quick stop in case of fault:
If the axis is to be stopped with a quick stop — if possible —in case of a fault, activate this parameter. If the parameter
is deactivated, motion of the axis is no longer controlled by the drive controller.

8. A39 Maximum quick stop duration for enable off:
If you have selected 1: Active for parameter A44, define the maximum time after which the power unit is switched off
in A39.

9. A45 Quick stop end:
In this parameter, define whether a quick stop is considered ended when the axis is at a standstill or when the quick
stop request is canceled.

10. A62 Source /quick stop:

Select the source of the digital signal used to activate the quick stop.
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55 Parameterizing synchronous operation

The following chapters describe the basic procedure for parameterizing the master and slave axes for synchronous
operation. Different configuration options are available in DriveControlSuite to operate one or more axes in synchronous
operation.

You can find more information on synchronous operation and the various configuration options under Synchronous
operation — Concept [P 101].

/\ WARNING!

Injury to persons and material damage due to axis movement!

When referencing the master (axis, master encoder or virtual master) or using the preset function for phasing, the master
value changes immediately and without a motion profile. As a result, coupled slave axes immediately follow the motion of
the master.

= Only execute the functions if there are no slave axes coupled with the master.

5.5.1 Scaling the master axis model

Scale the master axis model of the drive controllers for each SSI motion bus node as described below. The master axis
models of the drive controllers must be scaled identically.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the wizard Drive Based Synchronous application > Synchronous operation > Master: Axis model, scaling.

3. G30 Position range master:

Define the travel range of the axis.

4. G40 Circular length master:
If you have selected 1: Endless for G30, define the master position from which counting begins again at zero.

5. G46 Decimal places:
Define the number of decimal places for specifying and displaying the master positions.

6. G49 Master measure unit:

Define the desired unit of measure for the master positions. Any unit of measure can be selected (max. 8 characters).

Information

A change to parameter G46 moves the decimal separator for all master position values. Therefore, change G46 before
parameterizing other master position values and then check them.

The resolution of master position values has a direct effect on the smooth operation of the coupled slave axes. Therefore,
define a sufficient number of decimal places appropriate for your application.

Information

For the synchronous operation of multiple SB6 drive controllers via SSI motion bus, the master axis models of the slave axes
must be scaled identically to the axis model of the master value source. Scale the axis model identically from the start so
that you do not have to adapt position settings to the changed scaling afterwards.
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55.2 Projecting the SSI motion bus

Project the SSI motion bus as the basis for data exchange among multiple SB6 drive controllers in synchronous operation.
Parameterize the encoder scaling and the queried SSI data bits for all SSI motion bus nodes and select the function of
encoder connection X120 depending on the function of the respective drive controller.

For more information and setting instructions for the SSI motion bus, see SSI motion bus [» 104].

Parameterizing the master axis

For the master axis, parameterize the function of encoder connection X120 and, if necessary, the source for the encoder
simulation.

1. Select the wizard Encoder > X120.

2. H120 X120 function:

Select the function of encoder connection X120 depending on the master value source.
2.1. If a master encoder at X120 is acting as the master value source, select 76: SSI free setting.
2.2. If the master value for synchronous operation has a different origin, select 83: SSI simulation free setting.

3. If you have selected H120 = 83: SSI simulation free setting, select the wizard Encoder > X101 (DO)/X120 simulation:

Data source.

4. HB80 Source encoder simulation:

If you have selected H120 = 83: SSI simulation free setting, select the source for the encoder simulation.
4.1. If a master encoder is acting as the master value source, select 1: Master encoder (G122).
4.2. If avirtual master is acting as the master value source, select 2: Virtual master (G190).

4.3. If the actual position of the master axis is acting as the master value source, select 4: Current position (180).

Parameterizing the slave axes
Parameterize the function of encoder connection X120 and the source of the master position for all slave axes.
1. Select the wizard Encoder > X120.

2. H120 X120 function:

Select the function of encoder connection X120 depending on the master value source.
2.1. If H120 = 76: SSI free setting for the master axis, select 68: SSI passive for all slave axes.

2.2. If H120 = 83: SSI simulation free setting for the master axis, select 76: SSl free setting for the first slave axis and

68: SSI passive for all other slave axes.
3. Select the wizard Drive Based Synchronous application > Synchronous operation > Slave.

4. G27 Source master position:
Select 1: Master encoder as the source for the master position, regardless of the master value source for synchronous

operation.
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Parameterizing the encoder settings
Parameterize the encoder settings identically for all SSI motion bus nodes.

1. H121 X120 numerator, H122 X120 denominator:
If you have selected H120 = 76: SSI free setting for the master axis, define the pair of values consisting of the

mechanical value and raw encoder value for scaling the encoder connected to X120.

2. H123 Encoder version:
If you have selected H120 = 76: SSI free setting for the master axis, select the version of the encoder connected to
X120.

3. H134 X120 SSI data bit:

Define the number of bits that are queried by the SSI encoder connected to X120 or simulated.

4. H136 Alarm bit:

If you have selected H120 = 76: SSI free setting for the master axis, parameterize the alarm bit if necessary.

5. H137 Monoflop time:
If you have selected H120 = 76: SSI free setting for the master axis, define 15 us as the monoflop time for the slave

axes. Repeat the steps for all SSI motion bus node.

5.5.3 Parameterizing the master axis

Parameterize the master axis according to your application as described below.

5.5.31 Parameterizing the virtual master

If a virtual master is used as the master value source, activate it in the first step and then limit the position, velocity,
acceleration and jerk for the virtual master.

Activating the virtual master

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions.

3. Activate the option Virtual master.

= In the list of wizards, the Virtual master wizard is displayed.

Information

To be able to control the additional virtual master function via fieldbus, expand the process data mapping using the
respective wizard (EtherCAT: Received process data RxPDO; PROFINET: Received process data RxPZD).

An overview of the virtual master parameters that can be written by the controller via fieldbus is provided by the Command
operating mode: Virtual master wizard. Add the required parameters to both the receive process data of the drive
controller and the transmit process data of the controller (motion command: G483; set value specifications: G484 — G488;
control words: G10, G12).
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Parameterizing the virtual master

v" You have activated the additional virtual master function.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Limit: virtual master.
3. G53 Virtual master move direction:
If you selected 1: Endless for G30 when parameterizing the master axis model, you define the permitted direction of
motion for the virtual master.
3.1. If motions in both directions are permitted, select 0: Positive and negative.
3.2. If motions are only permitted in one direction, select 1: Positive or 2: Negative accordingly.

4. G50 Virtual master maximal speed:

Define the maximum velocity of the virtual master.

5. G51 Virtual master maximal acceleration:

Define the maximum acceleration of the virtual master.

6. G54 Virtual master quickstop deceleration:

Define the maximum quick-stop acceleration of the virtual master.

7. G52 Virtual master maximal jerk:

Define the maximum jerk of the virtual master.

Information

The limiting values for the velocity, acceleration, quick stop and jerk of the virtual master (G50, G51, G52, G54) depend on
the limiting values of the slave axes.

To determine the maximum velocity for the virtual master, for example, convert the maximum velocity of each individual
slave axis together with the respective gear ratio 1417 Gear ratio numerator and 1418 Gear ratio denominator into an
alternative maximum velocity. The slave axis with the lowest maximum velocity is simultaneously the velocity limit value of
the virtual master.

Proceed in the same manner for the limit values for acceleration, quick stop and jerk.

Virtual master: Limiting the travel range
v" You have activated the additional virtual master function.

v' The travel range of the master is limited (G30 = 0: Limited).

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Limit: virtual master.

3. G146 Virtual master software limit switch +, G147 Virtual master software limit switch -:
In order to protect the travel range, limit the position of your axis if necessary using a positive or negative software

limit switch.
4. Select the Protection functions wizard.

5. U24 Level virtual master limit switch:
Select 3: Fault.

6. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master.

7. G57 Virtual master quickstop additional source:

Select 1: Error or 3: Enable or error.

= If the software limit switches are overshot, a quick stop of the virtual master is triggered.
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553.2 Parameterizing the master encoder

If a master encoder is used as the master value source, activate the interface you used to connect the master encoder to
the drive controller in the first step and then parameterize the master encoder together with the encoder interface.

Parameterizing the master encoder

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Encoder wizard > Master encoder: Scaling.

3. G104 Source master encoder:

Select the interface over which the master encoder is connected.

4, GA47 Distance factor numerator master, G48 Distance factor denominator master:

Define the conversion factor for the path of the master encoder in relation to the master position.
5. Select the Encoder wizard.

6. G297 maximum-speed master-encoder

Define the maximum permitted velocity for the master encoder.

Information

Parameterize G297 maximum-speed master-encoder according to your application case: If G297 is set too low, the
permitted maximum speed is exceeded even at normal operating speeds. If G297 is set too high, measuring errors of the
encoder can be overlooked.

G297 depends on the following parameters: G46 Decimal places, G47 Distance factor numerator master, G48 Distance
factor denominator master and G49 Master measure unit. If you have made changes to one of the parameters listed, adjust
G297 accordingly as well.

Master encoder: Parameterizing the interface

The available connections vary depending on the series and, if applicable, the terminal module of the drive controller.

v" You have selected the interface for the master encoder (G104 # 0: Inactive).
1. If you have connected the master encoder over the X4 interface, select the Encoder wizard > X4.

1.1. HOO X4 function:

Select the encoder model that is connected to the interface.
= The appropriate parameters are displayed based on the selected encoder model.

1.2. HO3 Encoder version:

Select whether the encoder design is rotational or translational.
1.3. Parameterize the interface according to the properties of the master encoder.

2. If you have connected the master encoder over the X101 or X103 (DI) interface, select the Encoder wizard > X101/
X103 (DI).

2.1. H40 DI encoder:
Select the encoder model that is connected to the interface.

= The appropriate parameters are displayed based on the selected encoder model.

2.2. H43 Encoder version:

Select whether the encoder design is rotational or translational.

2.3.  H41 DIl numerator, H42 DI denominator:

Parameterize the pair of values for scaling the encoder at the digital input.
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3. If you have connected the master encoder over the X120 interface, select the Encoder wizard > X120.
3.1. H120 X120 function:
Select the encoder model that is connected to the interface.
= The appropriate parameters are displayed based on the selected encoder model.
3.2.  H123 Encoder version:
Select whether the encoder design is rotational or translational.
3.3. Parameterize the interface according to the properties of the master encoder.
4. If you have connected the master encoder over the X140 interface, select the Encoder wizard > X140.
4.1. H140 X140 function:
Select the encoder model that is connected to the interface.
= The appropriate parameters are displayed based on the selected encoder model.
4.2. H143 Encoder version:
Select whether the encoder design is rotational or translational.
4.3. Parameterize the interface according to the properties of the master encoder.
554 Parameterizing slave axes

Parameterize the slave axes according to your application as described below.

5.5.41 Parameterizing the electronic gearbox

For the slave axes, optionally define a factor for the gear ratio of the electronic gearbox.

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
Select the wizard Drive Based Synchronous application > Synchronous operation > Electronic gear unit.

1418 Gear ratio denominator, 1417 Gear ratio numerator:

Define a factor for the gear ratio of the master position and axis movement in the form of a quotient (humerator and

denominator).
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5.6

Transmitting and saving the configuration

In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive

controllers over the network.

/A WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead

to unexpected axis movements.

Only change the configuration if you have visual contact with the axis.
Make sure that no people or objects are within the travel range.

For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

Network supports IPv4 limited broadcast

All drive controllers and the PC are in the same subnet (broadcast domain)

v" The drive controllers are switched on and can be found in the network.

1.

In the project tree, select the module under which you have recorded your drive controller and click Online

connection in the project menu.
= The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

Direct connection tab, IP address column:

Activate the IP addresses in question and confirm your selection with OK.

= The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

Select the module and the drive controller to which you would like to transfer the configuration. Change the selection

of transmission type from Read to Send.

Change the selection Create new drive controller:

Select the configuration that you would like to transfer to the drive controller.
Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

Online tab:

Click Establish online connections.

The configurations are transferred to the drive controllers.
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Saving a configuration

v" You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (AQO0).

= The Save values (A0O0) window opens.
2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

= The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A0O) window.

Information

For the configuration to take effect on the drive controller, a restart may be required in certain cases, such as after the
configuration is saved on the drive controller for the first time or when changes are made to the firmware or process data

mapping.

Restarting a drive controller

v’ You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

= The Restart (A09) window opens.
2. Select which of the connected drive controllers you want to restart.
3. Click Start action.

4. Confirm the safety note with OK.
= The Restart (A09) window closes.

The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

The selected drive controllers restart.

5.7 Testing the configuration

After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.

You can test the configuration quickly and easily via DriveControlSuite or, as an alternative, directly via the operating unit of
the drive controller.
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5.7.1 Testing jog mode
Jog control panel provides various commands for jog mode which you can use to test the configuration of your projected

axis model for plausibility.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the jog control panel

v" There is an online connection between DriveControlSuite and the drive controller.
v’ You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Jog control panel wizard.
3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.
4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using

the Jog+, Jog-, Jog step+ and Jog step- buttons.
6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog- cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in 114.

Jog+ and Jog- have a higher priority than Jog step+ and Jog step-.
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5.7.2 Testing the motion commands

Control panel motion provides a standard set of motion commands which you can use to test the basic movements of your
axis. The command set is based on the PLCopen standard and supplemented by manufacturer-specific motion commands.

If you are working with absolute position measuring systems and need the MC_MoveAbsolute motion command for
testing, you must reference an absolute position in advance (see Referencing absolute position [» 30]).

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

/\ WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the motion control panel
v' There is an online connection between DriveControlSuite and the drive controller.
v" You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Control panel motion wizard.

3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. K402 Command:

Select the desired command and define the position, velocity, acceleration, deceleration and jerk.
6. Execute the command by clicking Start.

7. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis precisely using the

individual commands.
8. Use your test results to optimize your configuration as necessary.

9. To deactivate the control panel, click on Control panel off.
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573 Testing synchronous operation

If you are working with a virtual master or master encoder as the master value source, first reference its absolute position
and test its functionality. Then, check the functionality of the master/slave coupling (Gearln).

5.7.31 Referencing and testing the virtual master

If you are working with a virtual master as the master value source, reference it and test its functionality using the Control
panel motion: Virtual master wizard.

/\ WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

= Only execute this function if there are no slave axes coupled with the master.

Referencing the virtual master
v' There is an online connection between DriveControlSuite and the drive controller.
v" You have completed the configuration for synchronous operation and saved it on the drive controller.

v" No safety function is active.

1. Select the master drive controller in the project tree and click on the desired projected axis in the project menu >

Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Control panel motion:

Virtual master.

3. Activate the control panel by clicking Control panel on.

= The control panel is active: The parameters and buttons which you can use to control the virtual master are
displayed.

4. In order to reference the actual position of the virtual master manually, click Set pos.

= The value of parameter G58 Virtual master preset position is transmitted to parameter G190 Actual position
virtual master.
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Testing the virtual master

v" There is an online connection between DriveControlSuite and the drive controller.

v

v

1.

10.

11.

You have completed the configuration for synchronous operation and saved it on the drive controller.

No safety function is active.

Select the master drive controller in the project tree and click on the desired projected axis in the project menu >

Wizard area.

Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Control panel motion:

Virtual master.

Activate the control panel by clicking Control panel on.

= The control panel is active: The parameters and buttons which you can use to control the virtual master are
displayed.

To test the virtual master, assign values to the following parameters.

G483 Virtual master command:

Select the motion command you would like to use to move the virtual master.

G484 Virtual master target position:

Define the set position to which the virtual master is to travel.

G485 Virtual master velocity:

Define the set velocity at which the virtual master is to travel.

G486 Virtual master acceleration:

Define the acceleration at which the virtual master is to travel.

G487 Virtual master deceleration:

Define the deceleration at which the virtual master is to travel.

G488 Virtual master jerk:

Define the jerk at which the virtual master is to travel.

To execute the motion command, click on Start.

= The values of parameters G190 Actual position virtual master, G191 Actual velocity virtual master and
G159 Virtual master PLCopen-state change according to the parameterization.

Information

The values of Control panel motion: Virtual master for the set velocity, acceleration and jerk of the virtual master are
limited using the Limit: virtual master wizard (parameters G485, G486 and G488 or parameters G50, G51 and G52).
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5.73.2 Referencing and testing the master encoder

If you are working with an external master encoder as the master value source, reference it and test its function by moving
it manually.

/A WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

= Only execute this function if there are no slave axes coupled with the master.

v" There is an online connection between DriveControlSuite and the drive controller.
v" You have completed the configuration for synchronous operation and saved it on the drive controller.

v" No safety function is active.

1. Select the master drive controller in the project tree and click on the desired projected axis in the project menu >

Wizard area.
2. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

3. G453 Source master reference set:

Enter the signal source for triggering the referencing.
4. Toreference the master encoder, trigger the referencing signal.
5. Select the Drive Based Synchronous application wizard > Synchronous operation > Master.
6. Move the master encoder mechanically.

= The value of parameter G122 Lead-position producer changes according to the movements of the master encoder.

5733 Testing the master/slave coupling

Test the master/slave coupling using Control panel motion and the 12: MC_Gearln motion command.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Information

To prevent an enabled axis from moving unnoticed in the background, active control panels are deactivated as soon as you

open a new wizard.

To test the master/slave coupling (Gear-In), you need multiple control panels at the same time. Therefore, open all

necessary wizards in the first step. In the second step, arrange them next to each other in window mode and only activate

the required control panels in the third step.

Opening wizards

1.

2.

Select the desired drive controller in the project tree and click on the master axis in the project menu > Wizard area.
Open the wizard according to the master value source.

2.1.  Virtual master:
Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Jog control
panel: Virtual master.

2.2. Master encoder:

Select the Drive Based Synchronous application wizard > Synchronous operation > Master.

2.3.  Motor axis model of the master axis:

Select the Drive Based Synchronous application wizard > Jog control panel.

Select the desired drive controller in the project tree, hold down [CTRL] and click on the first slave axis in the project
menu > Wizard area.

Select the Control panel motion wizard.
Select Windows in the menu bar > Show windows side by side.
= The wizards are arranged next to each other.

You can now move the master and check the behavior of the slaves at the same time without the control panels being
automatically deactivated.

Coupling the slave axis

v

v

There is an online connection between DriveControlSuite and the drive controller.
You have completed the configuration for synchronous operation and saved it on the drive controller.

You have opened all necessary wizards and arranged them next to each other in window mode.

Select the previously opened Control panel motion wizard of the slave axis.

Activate the control panel by clicking Control panel on.

= The control panel is active: The parameters and buttons which you can use to move the axis are displayed.

K402 Command:
Select 12: MC_Gearin.

Click on Start.

= Parameter E80 Operating condition indicates the state 29: Synchronous motion.

= The slave axis is active and coupled to the master.
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Moving the master

v" There is an online connection between DriveControlSuite and the drive controller.

v" You have completed the configuration for synchronous operation and saved it on the drive controller.

v’ You have opened all necessary wizards and arranged them next to each other in window mode.

1.

2.

Open the wizard according to your master value source.

Virtual master:
2.1. Select the previously opened Jog control panel: Virtual master wizard.
2.2. Activate the control panel by clicking Control panel on.

2.3.  Move the virtual master by using the jog method.

= The value in parameter G190 changes according to the position of the virtual master.
Master encoder:
3.1. Select the previously opened Master wizard.

3.2.  Move the master encoder mechanically.

= The value in parameter G122 changes according to the position of the master encoder.
Motor axis model of the master:

4.1. Select the previously opened Jog control panel wizard of the master axis.

4.2. Activate the control panel by clicking Control panel on.

4.3.  Move the master axis by using the jog method.

= The value in parameter 180 changes according to the position of the master axis.

= The actual position of the slave axis changes depending on the master position (Control panel motion wizard,

parameter 180).
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5.8 Parameterizing the Drive Based Synchronous application

The Drive Based Synchronous application provides two operating modes: Command operating mode and motion block
operating mode

The operating modes provide you with a standard set of motion commands based on PLCopen that are supplemented with
unique motion commands. The operating mode that is best suited to your application depends on your application case. If
you are coordinating motion sequences using a controller, use the command operating mode. If you are not using a
controller and are instead storing the motion profiles on the respective drive controller, use the motion block operating
mode.

The general motion variables are grouped in the mode-independent Data sources wizard. Depending on the operating
mode, unique wizards are also available which you can use to parameterize operating mode-specific motion variables. The
general or operating mode-specific motion variables you need to parameterize depend on your drive project.

If you would like to use set values from external sources for your project, parameterize them in the first step. Then,
continue with the operating mode-specific motion variables in the respective wizards.

5.8.1 General motion variables and signal sources

First, parameterize the general motion variables and signal sources before you begin parameterization of the operating
mode-specific motion variables. The motion variables that you need to parameterize depend on your drive project.

5.8.1.1 Parameterizing analog inputs

If the analog inputs serve as a source for the application in your drive project, parameterize the respective analog input as
described below. The number of available analog inputs depends on the configured terminal module.

For more information and continuous function charts for the analog inputs, see Analog inputs [» 80].
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5.8111 Parameterizing analog input Al1

Parameterize the analog input as a voltage source by defining a time constant for the associated filter and calibrating using
the maximum positive, maximum negative and 0 V voltage. After that, you can scale the analog input as needed.

If the analog input is the current source, calibrate using the maximum and minimum currents instead, and optionally enable

wire break monitoring.

Parameterizing analog input All

1.

2.

Select the Terminals wizard > Analog input 1.

F13 All lowpass filter:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

F15 Al1 wire break monitoring:

If you want to use analog input All as a current source and enable wire break monitoring, select 1: Active.

F116 All operating mode:

Select the operating mode of analog input Al1.

4.1. If analog input All is the voltage source, select 0: -10V to 10V.

4.2. |If analog input All is the current source, select 1: 0 to 20mA or 2: 4 to 20mA.

Calibrating analog input All (voltage source)

v" Analog input All is interpreted as a voltage source (F116 = 0: -10V to 10V).
1.

2.

Select the Terminals wizard > Analog input 1 > Analog input 1: Calibration.

Set the voltage source to the minimum voltage.

2.1.  F112 All maximum negative value:

Apply the value from parameter E110[1] for parameter F112.

2.2.  F114 All maximum negative % value:

Define the associated value for F112 in % in parameter F114.
Set the voltage source to the maximum voltage.

3.1. F111 All maximum positive value:

Apply the value from parameter E110[1] for parameter F111.

3.2.  F115 Al1l maximum positive % value:

Define the associated value for F111 in % in parameter F115.
Set the voltage source to 0 V voltage.

4.1. F110 All zero point offset:
Apply the value from parameter E110[1] for parameter F110.

F113 All deadband:

Optionally define a deadband to compensate for any noise of the 0 V voltage at the analog input.
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Calibrating analog input Al1 (current source)
v" Analog input All is interpreted as a current source (F116 = 1: 0 to 20mA or 2: 4 to 20mA).
1. Select the Terminals wizard > Analog input 1 > Analog input 1: Calibration.
2. Setthe current source to the minimum current.

2.1. F110 All zero point offset:
Apply the value from parameter E110[1] for parameter F110.

2.2.  F114 All maximum negative % value:
Define the associated value for F110 in % in parameter F114.

3. Set the current source to the maximum current.

3.1.  F111 AI1 maximum positive value:
Apply the value from parameter E110[1] for parameter F111.

3.2, F115 Al1 maximum positive % value:
Define the associated value for F111 in % in parameter F115.

Scaling analog input All

1. Select the Drive Based Center Winder application wizard > Analog inputs: Scaling > Analog input 1: Scaling.

2. G260 All scaling:
Select the scaling for the analog input.

2.1. If you want to use the value unscaled, select 0: Without scaling.
2.2. If you want to use the value unsigned, select 1: Absolute value.
2.3. If you want to use the value inverted, select 2: Inverting.

2.4. If you want to scale the value using a curve, select 3: X/Y characteristic.

= Parameters G261 and G262 for scaling the analog input using a curve are displayed.

3. G261 All X-value scaling, G262 Al1l Y-value scaling:
If you have selected 3: X/Y characteristic for G260, define the value pairs of the calibrated value and scaled value for

the scaling of the analog input.
= The scaling of the analog input is completed.

= The scaled value of analog input All is displayed in G270.
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5.811.2 Parameterizing analog input Al2

Parameterize the analog input as a voltage source by defining a time constant for the associated filter and calibrating using
the maximum positive, maximum negative and 0 V voltage. After that, you can scale the analog input as needed.

Parameterizing analog input Al2

1. Select the Terminals wizard > Analog input 2.

2. F23 AI2 lowpass filter:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Calibrating analog input Al2
1. Select the Terminals wizard > Analog input 2 > Analog input 2: Calibration.
2. Set the voltage source to the minimum voltage.

2.1.  F122 AI2 maximum negative value:
Apply the value from parameter E111[1] for parameter F122.

2.2.  F124 Al2 maximum negative % value:
Define the associated value for F122 in % in parameter F124.

3. Setthe voltage source to the maximum voltage.

3.1. F121 AI2 maximum positive value:
Apply the value from parameter E111[1] for parameter F121.

3.2.  F125 Al2 maximum positive % value:
Define the associated value for F121 in % in parameter F125.

4. Set the voltage source to 0 V voltage.

4.1. F120 AlI2 zero point offset:
Apply the value from parameter E111[1] for parameter F120.

5. F123 Al2 deadband:
Optionally define a deadband to compensate for any noise of the 0 V voltage at the analog input.

Scaling analog input Al2

1. Select the Drive Based Center Winder application wizard > Analog inputs: Scaling > Analog input 2: Scaling.

2. G263 Al2 scaling:
Select the scaling for the analog input.

2.1. If you want to use the value unscaled, select 0: Without scaling.
2.2. If you want to use the value unsigned, select 1: Absolute value.
2.3. If you want to use the value inverted, select 2: Inverting.

2.4. If you want to scale the value using a curve, select 3: X/Y characteristic.

= Parameters G264 and G265 for scaling the analog input using a curve are displayed.

3. G264 Al2 X scaling, G265 Al2 Y scaling:
If you have selected 3: X/Y characteristic for G263, define the value pairs of the calibrated value and scaled value for

the scaling of the analog input.
The scaling of the analog input is completed.

The scaled value of analog input Al2 is displayed in G271.
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5.811.3 Parameterizing analog input Al3

Parameterize the analog input as a voltage source by defining a time constant for the associated filter and calibrating using

the maximum positive, maximum negative and 0 V voltage. After that, you can scale the analog input as needed.

Parameterizing analog input Al3

1.

2.

Select the Terminals wizard > Analog input 3.

F33 Al3 lowp. filter:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Calibrating analog input Al3

1.

2.

Select the Terminals wizard > Analog input 3 > Analog input 3: Calibration.

Set the voltage source to the minimum voltage.

2.1.  F132 AI3 maximum negative value:

Apply the value from parameter E112[1] for parameter F132.

2.2.  F134 Al3 maximum negative % value:
Define the associated value for F132 in % in parameter F134.

Set the voltage source to the maximum voltage.

3.1. F131 AI3 maximum positive value:

Apply the value from parameter E112[1] for parameter F131.

3.2.  F135 Al3 maximum positive % value:

Define the associated value for F131 in % in parameter F135.

Set the voltage source to 0 V voltage.

4.1. F130 AI3 zero point offset:

Apply the value from parameter E112[1] for parameter F130.

F133 Al3 deadband:

Optionally define a deadband to compensate for any noise of the 0 V voltage at the analog input.

Scaling analog input Al3

1.

2.

Select the Drive Based Center Winder application wizard > Analog inputs: Scaling > Analog input 3: Scaling.

G266 Al3 scaling:
Select the scaling for the analog input.

2.1. If you want to use the value unscaled, select 0: Without scaling.

2.2. If you want to use the value unsigned, select 1: Absolute value.

2.3. If you want to use the value inverted, select 2: Inverting.

2.4. If you want to scale the value using a curve, select 3: X/Y characteristic.

= Parameters G267 and G268 for scaling the analog input using a curve are displayed.

G267 Al3 X-value scaling, G268 Al3 Y-value scaling:

If you have selected 3: X/Y characteristic for G266, define the value pairs of the calibrated value and scaled value for

the scaling of the analog input.

= The scaling of the analog input is completed.

= The scaled value of analog input Al3 is displayed in G272.
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5.81.2 Velocity — Parameterizing sources

If you are obtaining the set value for velocity from external sources for applications of the Drive Based Synchronous type,
enter this as described below.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

Set velocity — Parameterizing the source
If you are obtaining the set value for velocity from an external source, enter the source for the main set value.
v' Use the motion command MC_MoveSpeed or MC_MoveVelocity.
1. Select the Drive Based Synchronous application wizard > Data sources > External velocity: Data source.
2. G461 Source external velocity:
2.1. Ifananalog input acts as the source, select the corresponding input.

2.2. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G460.

2.3. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G811.

3. G460 External velocity:

If you have selected 4: Parameter G460 for G461, enter the set velocity here.

4. G811 Indirect read external velocity:

If you have selected 5: Indirect read parameter G811 for G461, enter the associated parameter coordinate here.

Additional velocity — Parameterizing the source

If you also want to regulate the set velocity, enter the source for the additional set value.
v" Use the motion command MC_MoveSpeed or MC_MoveVelocity.

v" You obtain the set velocity from an external source.
1. Select the Drive Based Synchronous application wizard > Data sources > External additional velocity: Data source.
2. G464 Source external additional velocity:

2.1. Ifananaloginput acts as the source, select the corresponding input.

2.2. |If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G463.

2.3. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G812.

3. G463 External additional velocity:
If you have selected 4: Parameter G463 for G464, enter the set velocity here.

4. G812 Indirect read additional external velocity:

If you have selected 5: Indirect read parameter G812 for G463, enter the parameter coordinate here.
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5.81.3 Velocity override — Parameterizing the source

If you would like to use a velocity override to scale the velocity profile of your motion commands, enter the source for the
velocity override.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

1. Select the Drive Based Synchronous application wizard > Data sources > Velocity override: Data source.
2. G467 Source velocity override:
2.1. If ananalog input acts as the source, select the corresponding input.

2.2. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G466.

2.3. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G813.

3. G466 Velocity override:

If you have selected 4: Parameter G466 for G467, enter the set velocity here.

4. G813 Indirect read velocity override:

If you have selected 5: Indirect read parameter G813 for G467, enter the parameter coordinate here.

5.81.4 Torque/Force — Parameterizing sources

If you have selected the motion command MC_TorqueControl for Drive Based Synchronous type applications and obtain set
values from external sources, enter the sources for the set torque/force and velocity bracketing.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

Set torque/force — Parameterizing the source
If you obtain the set value for torque/force from an external source, enter the source for the set torque/force.
v" You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Synchronous application wizard > Data sources > Set torque/force, velocity bracketing: Data

source.
2. G470 Source torque/force reference:
2.1. If ananalog input acts as the source, select the corresponding input.

2.2. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G469.

2.3. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G814.

3. G469 Torque/Force reference:
If you have selected 4: Parameter G469 for G470, define the value for set torque/force here. The value relates to

C03 Maximum positive torque/force and CO5 Maximum negative torque/force.

4, G814 Indirect read torque/force reference:

If you have selected 5: Indirect read parameter G814 for G470, define the associated parameter coordinate here.

5. G500 Torque/force ramp removal, G501 Torque/force ramp removal:

Define the ramps for the build-up or reduction of torque/force.

53



5 | Commissioning STOBER

Velocity bracketing — Parameterizing the source

If you obtain values for limiting the velocity from an external source, enter the source for the velocity bracketing.

v’ You are using the 9: MC_TorqueControl motion command.

1.

Select the Drive Based Synchronous application wizard > Data sources > Set torque/force, velocity bracketing: Data

source.

G473 Source velocity bracketing positiv:
2.1. If ananalog input acts as the source, select the corresponding input.
2.2. If you are transmitting data via fieldbus, select 4: Parameter G472.

G472 Velocity bracketing positiv:
If you have selected 4: Parameter G472 for G473, define the maximum limit that you want to permit for your

mechanical system.

G476 Source velocity bracketing negative:

4.1. If an analog input acts as the source, select the corresponding input.
4.2. |If you are transmitting data via fieldbus, select 4: Parameter G475.

G475 Velocity bracketing negative:
If you have selected 4: Parameter G475 for G476, define the maximum limit that you want to permit for your

mechanical system here.

Information

If you define the velocity bracketing using G472 or G475, you should allow the control enough room. Therefore, select a

value for the velocity bracketing that is greater than 1%. Values less than 1% are internally set to 1% and values greater
than 100% are internally set to 100%. G472 and G475 refer to 110 Maximal speed.
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5.8.2 Parameterizing motion block operating mode

The following graphic shows the signal flows of motion block operating mode. The elements shown in a lighter shade are
optional.

Motion blocks

Motion Motion
command variables

I e
sources

Subsequent
motion block

Controller -
[
or [

Controller
Override
DI

- Controller
=]

Fig. 3: Motion block operating mode: Signal flows

In the motion block operating mode, motion profiles are permanently stored on the drive controller in the form of motion
blocks. A motion block includes a PLCopen-compliant motion command which defines the basic motion method of the axis.
The associated motion variables supply specifications on velocity, acceleration, deceleration and jerk, which the motion
core of the drive controller uses to calculate the motion profile.

Motion blocks can be selected individually using motion block numbers and they can be linked with each other, i.e. they are
automatically processed in succession. In motion block linking, a linear, defined sequence as well as branches based on
conditions are both possible for the further motion block continuation. You can parameterize specifications on velocity
override and brake for each motion block individually.

In motion block operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a fieldbus

and terminals. The number of axes and motion blocks used determines the memory you need for your project.

Information

The motion variables available for this operating mode that you configure in the software depend on your application case
as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).
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Information

If an analog input serves as the source for the application, parameterize, calibrate and scale the respective analog input as
described in Parameterizing analog inputs [» 47].

Proceed as follows ...
= Activate motion block operating mode.
= Parameterize one or more motion blocks.
= Test the individual motion blocks using the motion block control panel.
= |f you want to link motion blocks with each other, define subsequent motion blocks and triggers for continuation.
= Test the motion block links using the motion block control panel.
= Define how the motion blocks are started.

= Parameterize the source for the continue, reset and, if necessary, stop signals.

5.8.21 Activating motion block operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard.

3. Operating modes area:

Activate the Motion block operating mode option.

= The corresponding wizards are displayed.

5.8.2.2 Limiting the torque/force using the operating mode

Basic torque/force limiting using the mechanical system takes place in the project configuration of the axis model. As an
option, you can parameterize an additional torque/force limit via the operating mode, either for all motion blocks together
or for each motion block individually.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Torque/force

limit: Data source.
2. )08 Source maximum T/F:

2.1. If you would like to specify the maximum value from the axis model for all motion blocks centrally, select
3: 100%.

2.2. If you would like to specify the maximum value using the operating mode for all motion blocks centrally, select
1: Parameter JO9.

2.3. If you would like to define an individual maximum value for each motion block, select 2: Parameter J25.

3. J09 Maximum torque/force:

If you have selected 1: Parameter J0O9 for JO8, enter the maximum permitted value for torque/force.

4. |If you have selected 2: Parameter J25 for J08, enter the maximum permitted value for torque/force during the
parameterization of individual motion blocks in J25 Maximum torque/force.

To do so, proceed as described in the chapter Parameterizing the motion block [» 57].
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Information

The mechanical torque/force limit is executed using the axis model (limit: C03 and C05). Additional limiting through the
operating mode is optional and applies to the maximum permitted values for torque/force that you defined in the axis
model (reference values: C03, C05).

5.8.2.3 Parameterizing motion blocks

Before you start parameterizing the individual motion blocks, determine whether you also want to limit torque/force using
the operating mode. You have already defined the maximum value for torque/force in the axis model, but you have the
option of specifying an additional limit for all motion blocks together or for each motion block individually.

For each motion block, select an appropriate motion command and parameterize the associated motion variables. You can
copy parameterized motion blocks completely to create other motion blocks.

Then, test the parameterization of the individual motion blocks using Motion block control panel.

Information

Before you start parameterizing the operating mode-specific motion variables, parameterize the general motion variables
and signal sources. If you obtain set values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and signal sources [P 47].

5.8.2.31 Parameterizing the motion block
To parameterize a motion block, first select the desired motion command, then parameterize the associated motion

variables according to your drive project.

v’ You have activated motion block operating mode.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode.
= By default, 16 motion blocks are available to you which you can parameterize individually.
2. To parameterize the first motion block, click its motion block number in the Number column.
= The details view for the first motion block is displayed.
3. J10 Name:

Define the name of the motion block.

4, )11 Command:

Select the desired motion command.

= The associated parameters are displayed.

5. )25 Maximum torque/force:
If you have also limited torque/force using the operating mode and have selected 2: Parameter J25 for J08, enter the

maximum permitted value for torque/force for each motion block.

6. Parameterize the selected motion command based on its associated parameter.

Information

Using J28 Velocity override enable, you activate the scaling of the velocity profile of a motion block. For motion blocks with
final velocity, the velocity override influences J14 Velocity and J18 End velocity equally, i.e. the relationship between J14
and J18 remains the same.
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Information

Use J21 Command Mode to define how the motion block, as the subsequent motion block, is executed for motion block

linking. If you select 0: Abort current command, the ongoing motion block is interrupted when the trigger is activated and

the subsequent motion block is executed immediately. If you select 1: Start when current command has finished, the

ongoing motion block is completed first before the subsequent motion block is started.

Moving the axis with a set velocity

v" You have selected the motion command MC_MoveSpeed or MC_MoveVelocity.

1.

J30 Source velocity:

Select the source from which you will obtain the set value for the velocity.
1.1. If you obtain the set value via fieldbus, select 0: Parameter J14.
1.2. If you obtain the set value from an external source, select 1: Parameter G462.

J14 Velocity:

If you have selected 0: Parameter J14 for J30, enter the set velocity.

J15 Acceleration, J16 Deceleration, J17 Jerk:

Enter the set values for acceleration, deceleration and jerk.

J28 Velocity override enable:

If you would like to apply a velocity override to the motion block, select 1: Active.

J21 Command Mode:

Select the mode in which the selected motion block, as the subsequent motion block, is to be executed.

Moving the axis with a set torque/force

v" You have selected the motion command MC_TorqueControl.

1.

132 Source reference torque/force:

Select the source from which you will obtain the set value for torque/force.
1.1. If you obtain the set value via fieldbus, select 0: Parameter J26.
1.2. If you obtain the value from external sources, select 1: Parameter G471.

126 Torque/Force reference:

If you have selected 0: Parameter J26 for J32, enter the set torque or set force.

J16 Deceleration, J17 Jerk:

Enter the set values for deceleration and jerk.

128 Velocity override enable:

If you would like to apply a velocity override to the motion block, select 1: Active.

J21 Command Mode:

Select the mode for the motion block in which it, as the subsequent motion block, is to be executed.
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Moving the axis to the set position

v

1.

You have selected the motion command MC_MoveAbsolute, MC_MoveAdditive or MC_MoveRelative.

J13 Position:

Enter the absolute or relative position to which the axis is to be moved.

J14 Velocity:
Enter the set value for the velocity.

J15 Acceleration, J16 Deceleration, J17 Jerk:

Enter the set values for acceleration, deceleration and jerk.

J18 End velocity:
Enter the final velocity with which you want to reach the set position J13.

J24 Waiting time at the end:
If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

J27 Engage brake at the end:
If you have parameterized a brake and it is to engage at the end of the motion block, select 1: Active.

J28 Velocity override enable:
If you would like to apply a velocity override to the motion block, select 1: Active.

J21 Command Mode:
Select the mode for the motion block in which it, as the subsequent motion block, is to be executed.

Information

For motion blocks with a final velocity that is not 0, a change of travel direction by the subsequent motion block is not

permitted.

Referencing the axis

v’ You have selected the motion command MC_Home.

1.

130 Referencing type:

Indicates what referencing type you have parameterized for the referencing process.

J16 Deceleration, J17 Jerk:
Enter the set values for deceleration and jerk with which the axis is stopped if referencing is interrupted by a control

panel.

J24 Waiting time at the end:
If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

J27 Engage brake at the end:
If you have parameterized a brake and it is to engage at the end of the motion block, activate J27.

128 Velocity override enable:
If you have parameterized a velocity override and would like to apply it to the motion block, select 1: Active.

Information

To parameterize the referencing process, click the Referencing link and proceed as described in the chapter Referencing

absolute position [P 30].
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Stopping the axis

v" You have selected the motion command MC_Halt or MC_Stop.

1.

J16 Deceleration, J17 Jerk:

Enter the set values for deceleration and jerk with which the axis is stopped.

J24 Waiting time at the end:

If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

J27 Engage brake at the end:

If you have parameterized a brake and it is to engage at the end of the motion block, activate J27.

Move the axis synchronously

v" You have selected the motion command MC_Gearln or MC_GearInPosition.

1.

J15 Acceleration, J16 Deceleration, J17 Jerk:
Enter the set values for acceleration, deceleration and jerk.

J13 Position:
If you have selected MC_GearlInPosition, enter the position of the axis from which the axis is to move synchronously
with the master.

J20 Position D (Master Sync Position):
If you have selected MC_GearlInPosition, enter the position of the master from which the axis is to move
synchronously with the master.

128 Velocity override enable:

If you would like to apply a velocity override to the motion block, select 1: Active.

Information

To decouple a slave axis from synchronous operation, you can use the motion commands MC_GearOut or MC_Halt, for
example. MC_GearOut decouples the axis and retains the last velocity before decoupling; MC_Halt brings the axis to a
standstill after decoupling.
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5.8.2.3.2 Parameterizing the motion block duration

If you are using an endless motion command to move the axis with a set velocity or set torque/force, for example, you can

switch to a subsequent motion block after a defined time using the additional motion block duration function and an

indirect trigger.

v

1.

You are using an endless motion command.

Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block >

Indirect trigger: Data source.

Activate the Motion block duration option.

= The additional function is activated and the associated parameter J452 FSM block duration is shown in the Motion
block wizard.

Click on the Motion block link.
= The Motion block wizard opens.

Number:
Use the arrow keys to select the number of the motion block for which you would like to define a motion block

duration.

J452 FSM block duration:

Enter the duration for which the motion block is to be executed.

Information

As soon as the motion block duration is reached, the information is stored in bit 0 of parameter J453 FSM end of block

duration. To continue on to a subsequent motion block once the motion block duration is reached, parameterize a

subsequent motion block using the interrupt signal with an indirect trigger as described in Parameterizing the subsequent
motion block with a trigger [P 63].

5.8.23.3 Copying a motion block

To make parameterization of similar motion blocks easier, you can apply the values from existing motion blocks.

v

v

You are in the Motion block wizard.

You have parameterized at least one motion block.

Number:

Select the number of the motion block to which you want to copy the values from an existing motion block.

Apply from:
Click on Apply from and select the existing motion block whose values you want to copy.

Confirm by clicking on OK.

= The values of the existing motion block are applied to the current motion block.

Adjust the copied values, such as J10 Name, if necessary.
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5.8.23.4 Testing the motion block parameterization

Motion block control panel provides all functions you need to test the parameterization of individual motion blocks.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a

controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to

prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause

unexpected axis movements.

Do not switch to other windows when the control panel is active.
Only use the control panel if you have visual contact with the axis.
Make sure that no people or objects are within the travel range.

For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

The drive controller is switched on.
You have established an online connection to the drive controller.

You have parameterized at least one motion block.
Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block control panel.

Click Control panel on and then Enable.
= The drive is controlled using the active control panel.

J311 Motion block selection:

Select the motion block whose parameterization you would like to test.

Test the positions, velocities, accelerations and brakes and optimize your parameterization based on your test results

if necessary.

If you want to link motion blocks with each other as subsequent motion blocks, first test the parameterization for each

motion block individually to be able to rule out errors in motion block linking.

In order to deactivate the control panel, click Control panel off.
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5.8.2.4 Parameterizing motion block linking

In order to configure rolling programs automatically, you can connect multiple motion blocks with each other in sequence.
To do so, link the motion blocks in question with each other as subsequent motion blocks and enter the associated signal
sources for continuation. The subsequent motion blocks that are assigned to a motion block are displayed in the motion
block overview.

Then, test the linking of the individual motion blocks using Motion block control panel.

5.8.2.41 Parameterizing subsequent motion blocks

You can define one or more possible subsequent motion blocks for each motion block. Continuation to the subsequent
motion block either happens automatically at the end of the motion block or is caused by a trigger. The trigger can either be
a direct trigger signal or a trigger condition that is configurable in the software (indirect trigger). Buffered subsequent
motion blocks are parameterized without triggers and are intended for the case where the axis is moved to a set position in
the previous motion block that is reached with the final velocity.

You can find more information on motion block linking and subsequent motion block under Motion block [» 79].

5.8.2.411 Parameterizing the subsequent motion block with a trigger

You can define up to five subsequent motion blocks that are each activated by a trigger signal or trigger condition (indirect
trigger) for each motion block in the Subsequent motion block wizard. Depending on the configuration, the subsequent
motion block is only executed at the end of the previous motion block, or the ongoing motion block is interrupted when an
interrupt signal is triggered or an interrupt condition occurs and the subsequent motion block is started.

For each subsequent motion block, define the signal sources for continuation by parameterizing either a direct trigger signal
or an indirect trigger condition. You can configure multiple triggers for each motion block. Each trigger can either activate a
subsequent motion block through interruption or a subsequent motion block at the end of the previous motion block. If
multiple triggers are active simultaneously, the sequence continues with the subsequent motion block with the highest
priority (A —E).

Information

Depending on the application case, you can either parameterize a regular subsequent motion block or a buffered
subsequent motion block at the end of the previous motion block. The use of a regular subsequent motion block at the end
rules out the simultaneous use of a buffered subsequent motion block for the same motion block, and vice versa. You can
combine subsequent motion blocks through interruption with regular subsequent motion blocks at the end and with
buffered subsequent motion blocks.

Information

J450 Source trigger and J439 Source indirect trigger are array parameters. The first element (J450[0], J439[0]) corresponds
to trigger 1, the second element (J450[1], J439[1]) corresponds to trigger 2, etc.
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Parameterizing the subsequent motion block at the end of motion block

Use subsequent motion blocks at the end of the motion block if you want to move the axis with a finite motion command
and automatically switch to the subsequent motion block when the specified set value is reached.

The following section explains the process as an example, based on the parameterization of subsequent motion block A. For
the parameterization of subsequent motion block B — E, proceed in the same manner.
v" You have parameterized at least two motion blocks.
v’ You are moving the axis with MC_MoveAbsolute, MC_MoveRelative or MC_MoveAdditive in the motion block to
which you would like to add a subsequent motion block.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a subsequent motion
block.

3. J281 Next motion block A at end:
If the subsequent motion block is to be executed once the motion block selected in Number has been completed,

select the subsequent motion block here.

4. J251 Source trigger next motion block A:

Select the trigger that activates continuation to the subsequent motion block.
5. Click on the Trigger: Source link.
= The Trigger: Data source wizard opens.

6. J450[0] Source trigger:
Select the source of the trigger signal used to start the subsequent motion block.

6.1. If you would like the subsequent motion block to be activated directly at the end of the previous motion block,
select 1: High.

6.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

6.3. If the subsequent motion block is to be executed when a configurable condition is fulfilled (indirect trigger),

select 2: Parameter and proceed as described in the section Parameterizing the indirect trigger.

Information

For subsequent motion blocks at the end of the motion block, the trigger condition is only evaluated at the end of the
ongoing motion block by using J281 —J285. Since the evaluation only takes place at the motion block end, J21 Command
Mode does not influence when the subsequent motion block is started. The subsequent motion block always starts at the
motion block end if the trigger condition is active.
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Parameterizing the subsequent motion block due to interruption

Use subsequent motion blocks due to interruption if you would like to interrupt the ongoing motion block when the trigger

is activated and continue to the subsequent motion block.
The following section explains the process as an example, based on the parameterization of subsequent motion block A. For
the parameterization of subsequent motion block B — E, proceed in the same manner.

v" You have parameterized at least two motion blocks.

v’ You have selected 0: Abort current command for the subsequent motion block in J21 Command Mode.
1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a subsequent motion
block.

3. J271 Next motion block A by interrupt:
If the subsequent motion block is to be executed as soon as the motion selected in Number is interrupted by an

interrupt signal, select the subsequent motion block here.

4. J251 Source trigger next motion block A:
Select the trigger that activates continuation to the subsequent motion block.

5. Click on the Trigger: Source link.
= The Trigger: Data source wizard opens.

6. J450[0] Source trigger:
Select the source of the trigger signal that activates continuation to the subsequent motion block.

6.1. |If a digital input (direct or inverted) acts as the source, select the corresponding input.

6.2. If the subsequent motion block is to be executed when a configurable condition is fulfilled (indirect trigger),

select 2: Parameter and proceed as described in Parameterizing the indirect trigger.

Information

For subsequent motion blocks due to interruption, the trigger condition is evaluated while the previous motion is still
running by using J271 —J275. J21 Command Mode controls when the triggered subsequent motion block is started. When
0: Abort current command is selected, the subsequent motion block is executed immediately after the trigger condition is
active. When 1: Start when current command has finished is selected, the subsequent motion block is buffered during

activation of the trigger condition, but not executed until the motion block end.

Information

For motion blocks with a final velocity, you can parameterize a special case: a buffered subsequent motion block with
trigger condition. To do so, use a subsequent motion block due to interruption (J271 —J275) with J21 Command Mode =
1: Start when current command has finished.

When 1: Start when current command has finished is selected, the subsequent motion block is buffered during activation of
the trigger condition, but not executed until the motion block end. This enables a fluid transition to the subsequent motion

block, depending on a trigger condition.
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Parameterizing the indirect trigger

Parameterize the trigger condition for motion block continuation. If you parameterize a subsequent motion block that is to
be triggered at the end of the previous motion block, the condition for continuation must be fulfilled before the set position
is reached.

v" You have selected 2: Parameter for J450[0] Source trigger.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block >

Indirect trigger: Data source.

2. J439[0] Source indirect trigger:
Activate the desired indirect trigger and enter the condition for continuation to subsequent motion block A.

2.1. If asimple parameter is used as the condition for continuation, select the BOOL notation: Coordinate.

2.2. If a certain bit of a simple parameter is used as the condition for continuation, select the bit notation:

Coordinate.Bit.

2.3. Ifanarray or record parameter is used as the condition for continuation, select the array notation:

Coordinate[Element].

2.4. If a certain bit of an array or record parameter is used as the condition for continuation, select the following

notation: Coordinate [Element] .Bit.

Information

Using J439, you can specify a parameter, a single bit or an element of an array parameter as the source for the indirect
trigger. Possible sources for indirect triggers include individual bits of the status or control word for control via fieldbus or
signals from additional functions such as motion block duration, comparator or cams.

BOOL notation Coordinate J439[0] = 186

The subsequent motion block is only
triggered if 186 In reference is fulfilled,
i.e. if the axis is referenced.

Bit notation Coordinate.Bit J439[0] = J453.0

You use J452 FSM block duration and
the triggering of the subsequent
motion block is to be time-controlled.
The information "Motion block
duration is reached" is stored in bit 0 of
J453 FSM end of block duration.

Array notation Coordinate[Element] J439[0] = 164[0]

The subsequent motion block is to be
triggered once the first cam position is
reached. The information for the first
cam is stored in array element 0 of
164 Cam result.

Combined notation Coordinate[Element] .Bit -

Tab. 4: Indirect trigger: Notations
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5.8.2.41.2 Parameterizing the buffered subsequent motion block

In the Subsequent motion block wizard, you can define a buffered subsequent motion block for each motion block. This
means that the subsequent motion block is already loaded while the previous motion block is still being executed.
Continuation therefore takes place automatically at the end of the previous motion block, without a delay and without a

trigger signal.

Information

Depending on the application case, you can either parameterize a regular subsequent motion block or a buffered
subsequent motion block at the end of the previous motion block. The use of a regular subsequent motion block at the end
rules out the simultaneous use of a buffered subsequent motion block for the same motion block, and vice versa. You can
combine subsequent motion blocks through interruption with regular subsequent motion blocks at the end and with
buffered subsequent motion blocks.

Parameterizing the buffered subsequent motion block

Use a buffered subsequent motion block if you are moving the axis in the previous motion block with a set position
(MC_MoveAbsolute, MC_MoveRelative, MC_MoveAdditive) and would like to transition fluidly into the next motion upon
reaching the set position with the final velocity.

v" You have parameterized at least two motion blocks.

v" You are moving the axis in the previous motion block with MC_MoveAbsolute, MC_MoveRelative or
MC_MoveAdditive.

v’ You have selected 1: Start when current command has finished for the motion block intended as the subsequent
motion block in J21 Command Mode.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a buffered subsequent

motion block.

3. J286 Buffered motion block:
Select the motion block that is to follow the motion block selected in Number without a delay or trigger signal.

Information

If you add a buffered subsequent motion block using J286 Buffered motion block, make sure that J281 Next motion block A
at end up to J285 Next motion block E at end is set to -1: Inactive.

Information

For motion blocks with a final velocity, you can parameterize a special case: a buffered subsequent motion block with
trigger condition. To do so, use a subsequent motion block due to interruption (J271 —J275) with J21 Command Mode =
1: Start when current command has finished.

When 1: Start when current command has finished is selected, the subsequent motion block is buffered during activation of
the trigger condition, but not executed until the motion block end. This enables a fluid transition to the subsequent motion
block, depending on a trigger condition.
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5.8.2.4.2 Testing the motion block linking

Motion block control panel provides all functions that you need to test the motion block linking.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a

controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to

prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause

unexpected axis movements.

Do not switch to other windows when the control panel is active.
Only use the control panel if you have visual contact with the axis.
Make sure that no people or objects are within the travel range.

For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

The drive controller is switched on.
You have established an online connection to the drive controller.

You have parameterized at least one motion block.
Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block control panel.

Click Control panel on and then Enable.

= The drive is controlled using the active control panel.

J311 Motion block selection:

Select the motion block whose linking with the subsequent motion block you would like to check.

Test the positions, velocities, accelerations and brakes and optimize your parameterization based on your test results

if necessary.
Repeat the tests for each additional motion block for which you have defined subsequent motion blocks.

In order to deactivate the control panel, click Control panel off.
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5.8.2.5 Parameterizing the type of motion block

Define how the motion blocks are to be started. Motion block operating mode offers the option to parameterize the direct

start of up to three motion blocks without a controller. If you would like to use a controller, parameterize the start signal by

defining the source for the execute signal and the source for the selection of the motion block to be started.

5.8.2.51 Parameterizing the direct motion block type

Motion block operating mode offers the option to parameterize the direct start of up to three motion blocks of your choice

without a controller.

1.

Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Direct motion

block start: Data source.

180 Activation direct motion block start:

In order to activate the direct motion block start, select 1: Active.

187 Selected direct motion block start 1:
Enter the number of the motion block that you would like to start directly.

J81 Source direct motion block start 1:
4.1. |If adigital input (direct or inverted) acts as the source, select the corresponding input.
4.2. If you would like to activate the motion block directly, select 2: Parameter J84.

184 Direct motion block start 1:
If you have selected 2: Parameter J84 for J81 and want to start the motion block directly from DriveControlSuite,

select 1: High.
Configure the direct start of a second and third motion block in the same way as the first motion block, if necessary.

6.1. If you want to parameterize the direct start for a second motion block, repeat the steps in the same way for
188, 182 and J85.

6.2. If you want to parameterize the direct start for a third motion block, repeat the steps in the same way for J89,
J83 and J86.

Information

If you have configured the direct start of multiple motion blocks, they are activated with a simultaneous start signal

according to your priority: J83 Source direct motion block start 3 > J82 Source direct motion block start 2 > J81 Source direct

motion block start 1.
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5.8.2.5.2 Parameterizing the execute signal

If you want to use a controller and start the motion block using an execute signal, define the source for the execute signal
and the source for the selection of the motion block that is to be started by the execute signal.

Defining a source for the execute signal
1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.

2. 1100 Source execute:

To start a motion block via a controller, select the source for the execute signal.
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 0 of the control word 1210 of the application is the source, select 2: Parameter.

Source for motion block selection

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Motion block

selection: Data source.

2. J03 Source motion block selection:

To be able to select a motion block via a controller, select the source for the motion block selection signal.

2.1. If the control word JO2 of motion block operating mode acts as the data source, select 1: Parameter J02 and
enter the number of the motion block to be started in the event of an execute signal in JO2Reference motion
block.

2.2. If digital inputs act as the source, select 2: Digital inputs and enter the digital inputs (direct or inverted) that
activate a controller or binary switch.

5.8.2.6 Parameterizing the motion block end control unit

The motion block end control unit allows you to monitor the status of up to 5 freely selectable motion blocks, making it
easier for you to keep track of the motion block linking.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block end control

unit.
2. Activate the desired number of motion blocks to be monitored using the respective option.
= Parameter J455[0] — [4] can be parameterized according to your selection.

3. 1455 Move reference block:

Select the number of the motion block whose status you wish to monitor.

= The state of the selected reference motion blocks can be observed in J457[0] — [4].

Information

The motion block end control unit indicates that the end of motion block has been reached (J457 = 1: High) as soon as the
motion core has completed the motion command to be executed (192 = 1: Active) and the actual motion block matches the
reference motion block (J300 = J455).

If J455 is subsequently changed, the motion block chain must first be run through completely before J457 displays the
correct state. If a motion block is executed several times, J457 is reset to 0: Low until the motion command is ended again.
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5.8.2.7 Parameterizing the continue, reset and halt signal

To use the continue function to resume an interrupted motion block, configure the sources of the continue and reset
signals. If you would like to use the motion command MC_Halt to stop a motion block during its run, also add the associated
signal source here.

You can find more information on the continue function, continuable motion commands and reasons for canceling under
Continue function [P 151].

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Operating

mode digital signals: Data source.

2. J917 Source continue:

To use the continue function to resume interrupted motion commands, select the source for the continue signal.
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte JO1 of the application acts as the source, select 2: Parameter JO1.

= Bit 2 of the control byte is set as the source.

3. )07 Source reset motion block:
To delete a canceled motion block from the continue memory and enable a different motion block start, enter the

source for the reset signal.
3.1. |If a digital input (direct or inverted) acts as the source, select the corresponding input.

3.2. If the control word JO1 is used as the source for the motion block operating mode, select 2: Parameter JO1.
= Bit 1 of the control word is set as the data source.

4. )06 Source MC_Halt motion block:

To be able to stop a motion block in general, select the source for the stop signal.
4.1. |If adigital input (direct or inverted) acts as the source, select the corresponding input.

4.2. If the control word JO1 is used as the source for the motion block operating mode, select 2: Parameter JO1.

= Bit 0 of the control word is set as the data source.
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5.8.3 Parameterizing command operating mode
The following graphic shows the signal flows of the command operating mode. The elements shown in a lighter shade are
optional.
Controller
Alternative
sources
Controller Continue . Controller
function < 4
DI oo
Controller
Override
Al

Fig. 4: Command operating mode: signal flows

In command operating mode, motion profiles are sent from a controller to the drive controller in the form of motion tasks.

A motion task includes a PLCopen-compliant motion command which defines the basic motion method of the axis. The
associated motion variables supply specifications on velocity, acceleration, deceleration and jerk, from which the motion
core of the drive controller calculates the motion profile.

The controller coordinates the time progression and selects the motion tasks for the drive controller that the positioning,
velocity and torque/force commands process and run. In the controller, you define the motion tasks. In the DS6, you
parameterize the signal sources from which the drive controller receives the motion tasks from the controller.

In command operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a fieldbus
and terminals.

Information

The motion variables available for this operating mode that you configure in the software depend on your application case
as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).
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Information

If an analog input serves as the source for the application, parameterize, calibrate and scale the respective analog input as
described in Parameterizing analog inputs [» 47].

Proceed as follows ...
= Activate command operating mode.
= Optional: Limit torque/force using the operating mode.
= Parameterize the command-specific motion variables.
= Define the source for the start signal.

= QOptional: Define the source for the continue signal.

5.8.31 Activating command operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Synchronous application wizard.

3. Operating modes area:

Activate the Command operating mode option.

= The corresponding wizards are displayed.

5.8.3.2 Limiting the torque/force using the operating mode

Basic torque/force limiting using the mechanical system takes place in the project configuration of the axis model. As an
option, you can parameterize an additional torque/force limit via the operating mode.

1. Select the Drive Based Synchronous application wizard > Data sources > Torque/force limit: Data source.

2. C132 Source maximum positiv T/F, C133 Source maximum negative T/F:

Select the source for the torque/force limit.
2.1. Ifananaloginput acts as the source, select the corresponding input.
2.2. If the limiting values are transmitted over a fieldbus, select 4: Parameter C232 or 4: Parameter C233.

3. If the limiting values are transmitted over a fieldbus, select Drive Based Synchronous application > Command

operating mode wizard.

4. )47 Maximum positive torque/force, J48 Maximum negative torque/force:

Enter the maximum permitted positive and negative values for torque/force.

Information

The mechanical torque/force limit is executed using the axis model (limit: CO3 and C05). Additional limiting through the
operating mode is optional and applies to the maximum permitted values for torque/force that you defined in the axis
model (reference values: C03, C05).
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5.8.3.3 Parameterizing command-specific motion variables

The parameters for the acceleration, deceleration and jerk motion variables are not included as standard in the process
data mapping. You can either store the values for the motion variables permanently on the drive controller or add the
corresponding parameters to the process data mapping in order to receive the values from the controller.

Information

Before you start parameterizing the operating mode-specific motion variables, parameterize the general motion variables
and signal sources. If you obtain set values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and signal sources [P 47].

5.8.3.31 Storing motion variables: Drive controller

If you want to store the specifications for acceleration, deceleration and jerk permanently on the drive controller, check the
default values in the Command operating mode wizard and, if necessary, adjust them to your drive project.

v" You have activated command operating mode.

v’ Parameters J44, J45 and J46 are not part of the process data mapping.
1. Select the Drive Based Synchronous application wizard > Command operating mode.

2. )44 Acceleration, J45 Deceleration, J46 Jerk:

Define the set values for acceleration, deceleration and jerk.

= The specifications for acceleration, deceleration and jerk are permanently stored on the drive controller.

Information

The parameters in the Command operating mode wizard are written by the controller once there is an online connection
between the drive controller and controller and provided that the parameters are part of the process data mapping. In this
state, you can read off the values in the parameters that the drive controller receives from the controller. Using parameter
J41 Motion-ID, you can identify the ongoing motion task in order to assign the status bit correctly.
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5.8.3.3.2 Storing motion variables: Process data mapping

If you want to specify the settings for acceleration, deceleration and jerk via a controller, add the required parameters to

both the receive process data of the drive controller and the transmit process data of the controller.

EtherCAT: Supplementing motion variables in PDO mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive

process data of the drive controller.

v

1.

2.

You have activated command operating mode.
Select the EtherCAT wizard > Received process data RxPDO.

Coordinate column:

Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.
2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

= The parameter is applied to the receive process data of the drive controller.

In the Name, Data type and Length columns, your information about the parameters is displayed.

Add your changes to the process data mapping also to the transmit process data of the controller.

PROFINET: Supplementing motion variables in PZD mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive

process data of the drive controller.

v’

1.

2.

You have activated command operating mode.
Select the PROFINET wizard > Received process data RxPZD.

Coordinate column:

Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.
2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

= The parameter is applied to the receive process data of the drive controller.

In the Name, Data type and Length columns, your information about the parameters is displayed.

Add your changes to the process data mapping also to the transmit process data of the controller.
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5.8.3.4 Parameterizing the start signal
Define the source for the execute signal in order to start a motion command selected in J40 in command operating mode.
1. Select the Drive Based Synchronous application > Data sources > Application digital signals: Data source.
2. 1100 Source execute:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. |If the control word 1210 of the application acts as the source, select 2: Parameter.

= Bit 0 of the control word is set as the data source.

5.8.3.5 Parameterizing the continue signal

To use the continue function to resume an interrupted movement command, configure the source of the continue signal. If
you do not use the continue function, select a new command using J40 and start it using the start signal (execute).

You can find more information on the continue function, continuable motion commands and reasons for canceling under
Continue function [» 151].

1. Select the Drive Based Synchronous application > Command operating mode > Operating mode digital signals: Data

source.

2. )38 Source continue:

To use the continue function to resume interrupted motion commands, select the source for the continue signal.
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte J37 for the command operating mode acts as the source, select 2: Parameter.

= Bit 0 of the control byte is set as the source.
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6 More on Drive Based Synchronous?

The following chapters summarize the important terms, modules and relationships concerning Drive Based Synchronous.

6.1 Drive Based Synchronous - Concept

Applications such as Drive Based Synchronous, which calculate and adjust the motions in the drive itself, are referred to as
drive-based systems. They are either networked via a fieldbus or obtain signals and set values using analog and digital
hardware inputs.

The Drive Based Synchronous application provides you with a standard set of motion commands based on PLCopen, which
is supplemented by your own motion commands and thus offers flexible drive-based motion control for the position,
velocity and torque/force control types.

The motion commands are combined into corresponding operating modes for different applications. Depending on the
selected operating mode, the motion variables required for parameterizing individual motion profiles, such as set or limit
values, are recorded.

In addition, the Drive Based Synchronous application provides you with various additional functions for different
applications, such as jerk limitation, motion block linking, cam control unit or PID controller.

Various technological functions are available for the synchronous operation of multiple axes (multi-axis movements). As a
rule, a master specifies set values which the coupled slave axes follow according to the specified proportional ratio. For
example, a real axis, master encoder or virtual master can serve as the master.

Based on all parameterized data, the motion core finally calculates an individual motion profile. Specified set values are
transmitted to the control cascade, which in turn activates the motor.

Additional wizards such as control panels or jog mode help with commissioning and the configuration test or are designed
for emergency operation.

The following graphic shows the components and configuration steps for the Drive Based Synchronous application. The
elements shown in a lighter shade are optional.
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Fig. 5: Components and configuration steps

6.1.1 Operating modes

The operating modes of the Drive Based Synchronous application involve command sets bundled by application for
configuring individual motion profiles for production operation.

The drive functions of these operating modes span from simple functions like position, velocity and torque/force control
types to technology functions for individual axis applications to a synchronous operation of multi-axis systems.

Thanks to flexible, user-defined adjustment options for the operating modes, the Drive Based Synchronous application
offers a compact — yet extremely variable — scope of functions that is suitable for a wide range of application cases in drive
technology. After selecting the suitable operating mode for the respective application case, users concentrate just on
parameterizing the most important sequences for their application.

Note that a drive controller can only process one operating mode per axis.
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6.1.1.1 Motion block

In motion block operating mode, motion properties are predefined in the form of motion blocks. Special linking options
allow for complete motion sequences to be set up that make it possible to execute sequences of motions quickly —
regardless of whether an external controller is connected or the motion sequences are executed through digital signals.

Typical application examples are small machine automations or machine modules with predefined motion sequences.

Motion block linking

You can define one or more possible subsequent motion blocks for each motion block. Continuation to the subsequent
motion block either happens automatically at the end of the motion block or is caused by a trigger. The trigger can either be
a direct trigger signal or a trigger condition that is configurable in the software (indirect trigger).

For subsequent motion blocks with triggers, a distinction is made between subsequent motion blocks that are triggered at
the end of the previous motion block and subsequent motion blocks that interrupt the previous motion block when an
interrupt signal is triggered. The continuation can be executed by a direct or indirect trigger in either case.

Subsequent motion blocks at the end of a motion block are triggered as soon as the set value of a finite motion command is
reached and the trigger is active. For subsequent motion blocks due to interruption, a finite or endless motion is
interrupted and continued in the subsequent motion block as soon as the trigger is active. For example, the ongoing motion
can be interrupted when a sensor or light barrier is triggered and the axis stopped.

Buffered subsequent motion blocks are parameterized without triggers and are intended for the case where the axis is
moved to a set position in the previous motion block that is reached with the final velocity. In order to continue the motion
fluidly and start the next motion command without a delay or standstill, the subsequent motion block is loaded in advance
(buffered) while the previous motion block is still being executed. The continuation happens automatically at the end of the
previous motions block.

6.11.2 Command

Command operating mode enables a drive controller to run parameterizable motions. In this process, a range of motion
commands are processed that correspond to the behavior of the motion control blocks of the PLCopen standard.

A controller coordinates the time sequences by selecting motion commands based on PLCopen, such as MC_MoveAbsolute
(move to absolute set position) or MC_MoveRelative (move relative to actual position).

Parameters such as set position, velocity or torque limit can be defined individually.

Typical application examples are individual axis movements that are communicated by a controller (PLC) to the drive
controller.

6.1.2 Jog mode

For commissioning, emergency operation and maintenance or repair work, the manufacturer-specific jog mode (manual
movement) is available. Using jog mode, you can move the drive independently of the controller, for example.

You can use jog mode through the operating unit of the drive controller, the jog control panel or a controller that applies
the manual movement.

79



6 | More on Drive Based Synchronous? STOBER

6.1.3 Control panels

The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application in the respective operating mode before you switch to normal operation.

The following control panels are available:
= Jog control panel is used to check the projected axis model in jog mode.

= Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

= Motion block control panel is used to check the parameterized motion block operating mode and provides you with all
the functions you need to test the parameterization of individual motion blocks or motion block linking.

= Jog control panel: Virtual master enables you to move the virtual master in jog mode to test synchronous operation.

= Control panel motion: Virtual master enables you to move the virtual master via PLCopen compliant motion commands
to test synchronous operation.

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

6.1.4 Motion core

Based on the projected and parameterized data, the motion core calculates a motion profile and associated detail
movements as a basis for the drive controller as well as mandatory set values for the control cascade.

6.15 Data sources

The signals for controlling the drive controller, i.e. control signals for the start of motion, motion limits or set value
specifications, can be obtained from various external sources.

A fieldbus is usually acts as the signal source, but analog or digital hardware inputs, or even mixed operation made up of
the above-listed sources, can also be used to control the drive controller.

Values that are obtained from external data sources are usually adapted to the stored reference values automatically, i.e.
calibrated and calculated with scaling.

6.1.5.1 Analog inputs

The analog inputs of the drive controller can serve as sources for set and actual values of the application in your drive
project if, for example, you use sensors to measure motion variables such as velocities or torques/forces.

The available connections vary depending on the series and, if applicable, the terminal module of the drive controller.

For more information on the available connections, refer to the manual of the respective drive controller (see Further
information [P 156]).

Information

If an analog input serves as the source for the application, parameterize, calibrate and scale the respective analog input as
described in Parameterizing analog inputs [P 47].
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Analog input All1

Depending on whether analog input All is used as a voltage source or current source, the following continuous function

charts serve as examples (operating mode: F116).
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X100.1 —»| +

X100.3 —»( -

Fig. 6: Continuous Function Chart: analog input Al1 (F116 = 0: -10V to 10V)
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Fig. 7: Continuous Function Chart: analog input Al1 (F116 = 1: 0 to 20mA)
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Fig. 8: Continuous Function Chart: analog input Al1 (F116 = 2: 4 to 20mA)

81



6 | More on Drive Based Synchronous? STOBER
Analog input Al2
For analog input Al2 as a current source, the following continuous function chart serves as an example.
Calibration
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Fig. 9: Continuous Function Chart: analog input Al2
Analog input AI3
For analog input Al3 as a current source, the following continuous function chart serves as an example.
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Fig. 10: Continuous Function Chart: analog input AI3
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6.1.6 Additional functions

Each of the available operating modes can be expanded by drive-based additional functions. For example, these offer
convenient monitoring of process variables such as position, velocity or torque/force (cams, comparators) or control of
external process variables (PID controller).

6.1.6.1 Additional counter function

The additional counter function in Drive Based type applications provides you with up to 4 independent counters with
which you can implement smaller automation tasks directly in the drive controller, such as direct or indirect control of the
digital outputs.

Function

For each counter, you define a comparison value, a digital signal for increasing the counter reading and a digital signal for
resetting the counter reading (comparison value: N41; increase source: N43; reset source: N46). With each rising edge of
the counter signal, the counter reading is increased by 1 until the comparison value is reached (counter reading: N44).
When the comparison value is reached, a status signal is issued and further counter signals are ignored until the counter
reading is reset or the comparison value is increased (status: N42).

Signals
A
Counting
I I I I >
| I T T T R B t
| | | | | | | I
———————————————— AT T TTTOTT T
Reset | [ I N R I | I | _
e
Counter reading
3 = Comparison value
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1 | | T
_______________ ) —-:-—1'——' _'I__
I
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>

Fig. 11: Additional counter function: Example

The digital inputs of the drive controller (direct or inverted), parameters with the BOOL data type or individual bits of
parameters with the BYTE, WORD or DWORD data type (example bit addressing: E49.4 for Switch on inhibit reason = STO)
can serve as the source for the signals for increasing and resetting the counter status. The reset signal has priority and is
executed immediately; as long as it is active, the counter reading remains at 0 and rising edges to increase the counter
reading are ignored.
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6.1.6.1.1 Parameterizing counters

To parameterize the additional counter function, proceed as described below.

1.

10.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

Select the Drive Based Synchronous application wizard > Additional functions.

Activate the Counter option.

= The additional function is activated and the associated wizards and parameters are displayed.
Select the Drive Based Synchronous application wizard > Additional functions > Counters.

Number:

Select the desired counter and activate it using the corresponding option.

= The associated parameters are displayed.

N41 Counter comparison value:

Define the comparison value.

N43 Source counter:

Select the source for the signal that increases the counter reading by 1 until the comparison value is reached.
7.1. If a parameter is the source, select 2: Parameter.
7.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

N45 Counter indirect reading:
If a parameter is used as the source for increasing the counter, define the desired coordinate, if necessary with bit

addressing.

N46 Source reset counter reading:

Select the source for the signal that resets the counter reading to 0.
9.1. If a parameter is the source, select 2: Parameter.
9.2. |If adigital input (direct or inverted) acts as the source, select the corresponding input.

N47 Reset counter reading via parameter:
If a parameter is used as the source for resetting the counter, define the desired coordinate, if necessary with bit

addressing.
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6.1.6.1.2 Parameterizing counters: Examples

For example, you can use the additional counter function to control the digital outputs directly or indirectly (using the
additional INT32 comparator function) by reaching the comparison value.

In motion block operating mode, the additional counter function offers you options for automating motion block
continuation, e.g. for repeating a motion block as often as required or interrupting a motion block after a certain number of
events.

You can find more information on parameterizing motion blocks, subsequent motion blocks and triggers under
Parameterizing motion block operating mode [P 55].

Controlling a digital output directly

To control a digital output directly via the counter, you can use the status of the counter as a source.
1. Activate the additional counter function.
2. Select the Counters wizard.
3. Parameterize the counter according to your application case.
4. Select the status of the counter as the source for the desired digital output (e.g. DO1: F61 = N42).

= The digital output is controlled directly via the status of the counter.

Controlling a digital output indirectly (INT32 comparator)

To indirectly control a digital output, you can use the additional counter and INT32 comparator functions in combination
with each other. If you use the INT32 comparator to check whether the current counter reading fulfills a certain condition,

you can control a digital output depending on the result of the comparator.
1. Activate the additional counter and comparator functions.
2. Select the Counters wizard.
3. Parameterize the counter according to your application case.
4. Select the INT32 comparators wizard.
5. Parameterize the INT32 comparator according to your application case.

5.1. C78 Source INT32 comparator:

Select the counter reading N44 as the source for the INT32 comparator.
6. Select the result of the INT32 comparator as the source for the desired digital output (e.g. DO1: F61 = C83).

= The digital output is controlled indirectly via the counter reading.
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Interrupting a motion block

To interrupt a motion block after a certain number of events, parameterize a motion block with an endless motion
command, as well as a subsequent motion block using an interrupt with a motion command to stop an ongoing motion. The
subsequent motion block is triggered by an indirect trigger, using the status of the counter as the source.

1. Activate the additional counter function.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the Motion block wizard.

5. Parameterize at least motion block 0 and motion block 1 according to your application.

5.1. J11[0] Command:
Select for motion block 0 an endless motion command (e.g.8: MC_MoveSpeed).

5.2. J11[1] Command:
Select a motion command to stop for motion block 1 (e.g. 5: MC_Stop).

6. For motion block 0, parameterize the motion block start (e.g. J80 = 1: Active; J81 = 3: DI1; J87 = 0).
7. Select the Subsequent motion block wizard.

8. J271[0] Next motion block A by interrupt:
Select motion block 1 as the subsequent motion block using interrupt for motion block 0.

9. Select the Trigger: Data source wizard.

10. J450[0] Source trigger:
To parameterize the status of the counter as an indirect trigger for the subsequent motion block, select 2: Parameter.

11. Select the Indirect trigger: Data source wizard.

12. J439[0] Source indirect trigger:
Activate the indirect trigger and define the status of the counter N42 as the source.

= As soon as the counter has reached the comparison value, motion block 0 (8: MC_MoveSpeed) is interrupted by
motion block 1 (5: MC_Stop) as a subsequent motion block by interrupt.
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Repeating a motion block

To execute a motion block for a certain number of repetitions, parameterize a motion block with a finite motion command
and a wait time at the end, as well as a subsequent motion block at the end with the 0: MC_DoNothing motion command.
The subsequent motion block is triggered by an indirect trigger using the status of the counter as the source as soon as the
desired number of repetitions has been reached.

Information

The status byte in the motion block operating mode indicates a motion block as ended if the motion core has successfully
completed the motion command to be executed and if there is either no subsequent motion block (single motion block or
end of the motion block chain) or if a wait time at the end has been parameterized for a motion block with a subsequent
motion block and the subsequent motion block has not been started yet x(status byte: 1302, bit 3; motion core: 192; wait
time: J24).

If bit 3 of the status byte J302 is used as the source for the additional counter function in motion block operating mode, the
wait time at the end should be at least twice the cycle time (cycle time: A150).

1. Activate the additional counter function.
2. Select the Counters wizard.
3. Parameterize the counter according to your application case.

3.1. N41 Counter comparison value:

Define the desired number of motion block repetitions as the comparison value.

3.2.  N43 Source counter, N45 Counter indirect reading:
To count the number of times a motion block has been completed using the status byte of motion block
operating mode, select N43 = 2: Parameter and N45 = J302.3.

4. Select the Motion block wizard.
5. Parameterize at least motion block 0 and motion block 1 according to your application.

5.1. J11[0] Command:
Select a finite motion command for motion block 0 (e.g. 2: MC_MoveRelative).

5.2. J24 Waiting time at the end:

Define the desired wait time at the end for motion block 0.

5.3. J11[1] Command:

Select motion command 0: MC_DoNothing for motion block 1.
6. For motion block 0, parameterize the motion block start (e.g. J80 = 1: Active; J81 = 3: DI1; J87 = 0).
7. Select the Subsequent motion block wizard.

8. To be able to both repeat and interrupt motion block 0, parameterize two subsequent motion blocks for motion block
0.

8.1. J281[0] Next motion block A at end:
Select motion block 1 as the subsequent motion block at the end of motion block 0 (0: MC_DoNothing).

8.2. J282[0] Next motion block B at end:
Select motion block 0 as the subsequent motion block at the end of motion block 0 (2: MC_MoveRelative).

= Subsequent motion block A is executed with higher priority than subsequent motion block B if both subsequent
motion blocks are triggered simultaneously.

9. Select the Trigger: Data source wizard.
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10.

11.

12.

13.

J450([0] Source trigger:

To parameterize the status of the counter as an indirect trigger for subsequent motion block A, select 2: Parameter.

J450[1] Source trigger:

To automatically repeat motion block O, select 1: High as the trigger for subsequent motion block B.

= Subsequent motion block B is executed until subsequent motion block A is triggered (priority: J281 > J282).
Select the Indirect trigger: Data source wizard.

J439[0] Source indirect trigger:

Activate the indirect trigger and parameterize the status of the counter N42 as the source.

As soon as the counter has reached the desired number of repetitions, motion block 1 (0: MC_DoNothing) is executed
at the end of motion block 0 (2: MC_MoveRelative) due to its higher priority.
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6.1.6.2 Additional motor potentiometer function

In Drive Based Synchronous type applications, the additional motor potentiometer (MOP) function provides you with the
option of adjusting an electromechanical potentiometer, for example for set value specification, for direct control of the
analog outputs or for indirect control of the digital outputs.

Function

The motor potentiometer can be adjusted continuously via digital up and down signals, for example for specifying set
values for axis movements via the output value (output value: G373). The output value can be limited by a maximum
positive and a maximum negative value (limit: G362, G363; limit value reached: G374). Either the digital inputs of the drive
controller or the graphical programming can serve as the source for the up and down signals (source: G364, G365). The
initialization signal has priority over the up and down signals and is executed immediately; the initialization value is freely
definable (source: G369; value: G366).

Signals Signals
A A

Fig. 12: Motor potentiometer: Linear and stepwise calculation

You can use the operating mode of the motor potentiometer to influence both the calculation of the output value and the
storage behavior (operating mode: G368). The output value is calculated either linearly or in steps and can be saved either
with an active enable signal, prior to the next restart of the drive controller or in non-volatile memory. The parameterized
ramp (ramp: G361) applies to both the linear and stepwise calculations. With a linear calculation, the output value is
changed for the duration of the incoming up or down signal. With a stepwise calculation, the output value is changed by the
parameterized increment at signal input (increment: G367). If another up or down signal is received while the set value has
not yet been reached, it is adjusted by the corresponding increment. If the up and down signals are active at the same time,
the output value remains unchanged in both operating modes.
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6.1.6.2.1 Parameterizing motor potentiometers

To parameterize the additional motor potentiometer function, proceed as described below.

1.

10.

11.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

Select the Drive Based Synchronous application wizard > Additional functions.
Activate the Motor potentiometer option.
= The additional function is activated and the associated wizards and parameters are displayed.

Select the Drive Based Synchronous application wizard > Additional functions > Motor potentiometer.

G361 Motor potentiometer ramp:

Define the ramp for calculating the output value.

G362 Motor potentiometer positive maximum value, G363 Motor potentiometer negative maximum value:

Define the maximum permissible positive and negative output values of the motor potentiometer.

G364 Source motor potentiometer up, G365 Source motor potentiometer down:

Select the sources for the up and down signals of the motor potentiometer.
7.1. If the graphical programming is used as the source, select 2: Parameter.
7.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

G368 Motor potentiometer operating mode:

Select the desired operating mode for the motor potentiometer.

8.1. To calculate the output value of the motor potentiometer linearly, select 0: Linear, 2: Linear (remanent) or
4: Linear (enable-dependent), depending on the desired storage behavior.

8.2. To calculate the output value of the motor potentiometer in steps, select 1: Step-by-step, 3: Step-by-step

(remanent) or 5: Step-by-step (enable-dependent), depending on the desired storage behavior.

G367 Motor potentiometer increment:

If you calculate the output value of the motor potentiometer in steps, define the desired increment.

G366 Motor potentiometer initialization value:

Optionally define the desired initialization value.

G369 Source motor potentiometer initialization:

Select the source for the initialization signal of the motor potentiometer.
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6.1.6.2.2 Parameterizing motor potentiometers: Examples

For example, you can use the additional motor potentiometer function to specify set values for the velocity, velocity
override or torque/force and thus control the axis directly in local operation, e.g. during commissioning, if the controller
fails or if the machine has no controller at all. Using the motor potentiometer, you can also control the analog outputs
directly or the digital outputs indirectly (using the additional REAL32 comparator function).

Controlling an analog output directly

To control an analog output directly, you can use the output value of the motor potentiometer as the source.

=

Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.
4. Select the Analog output 1 or Analog output 2 wizard.

5. F40 AO1 source, F50 AO2 source:

Select the output value of the motor potentiometer G373 as the source for the desired analog output AO1 or AO2.

6. FA41 AO1 reference value source, F51 AO2 reference value source:

If necessary, delete the reference value of the desired analog output.

= The analog output is controlled directly via the motor potentiometer.

Controlling a digital output indirectly (REAL32 comparator)

To indirectly control a digital output, you can use the additional motor potentiometer and INT32 comparator functions in
combination with each other. If you use the REAL32 comparator to check whether the output value of the motor
potentiometer fulfills a certain condition, you can control a digital output depending on the result of the comparator.

1. Activate the additional motor potentiometer and REAL32 comparator functions.
2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the REAL32 comparators wizard.

5. Parameterize the REAL32 comparator according to your application case.

5.1. C65 Source REAL32 comparator:

Select the output value of the motor potentiometer G373 as the source for the REAL32 comparator.
6. Select the result of the REAL32 comparator as the source for the desired digital output (e.g. DO1: F61 = C75).

= The digital output is controlled indirectly via the motor potentiometer.
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Specifying a set velocity (external velocity)

To specify a set velocity via the motor potentiometer, select its output value as the source for the external velocity and use

this as the set value source for the motion command.

1.

2.

8.

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the External velocity: Data source wizard.

G461 Source external velocity:

Select 5: Indirect read parameter G811.

G811 Indirect read external velocity:
Select the output value of the motor potentiometer G373 as the source for the external velocity.
= The output value of the motor potentiometer serves as the source for the external velocity.

= The external velocity can be provided as a set value specification by accessing parameter G462.

For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J30.

7.1. J11 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. )30 Source velocity:

Select 1: Parameter G462 as the source for the external velocity.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J52.

8.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

8.2. )52 Source velocity 1:

Select 1: Parameter G462 as the source for the external velocity.

= The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is

carried out using maximum permissible speed 110.
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Specifying a set velocity (external additional velocity)

To additionally regulate the set velocity via the motor potentiometer, select its output value as the source for the external

additional velocity and use this as the set value source for the motion command.

v

1.

2.

=

You are using command operating mode or velocity, torque/force operating mode.
Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.

Select the External additional velocity: Data source wizard.

G464 Source external additional velocity:

Select 5: Indirect read parameter G811.

G812 Indirect read additional external velocity:
Select the output value of the motor potentiometer G373 as the source for the external additional velocity.
= The output value of the motor potentiometer serves as the source for the external additional velocity.

= The external velocity can be provided as a set value specification by accessing parameter G465.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J54.

7.1. 140 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. )54 Source velocity 2:

Select 1: Parameter G465 as the source for the external additional velocity.

The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is
carried out using maximum permissible speed 110.
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Specifying the velocity override

To specify a velocity override via the motor potentiometer, select its output value as the set value source and apply the

velocity override to the motion command.

1.

2.

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the Velocity override: Data source wizard.

G467 Source velocity override:

Select 5: Indirect read parameter G813.

G813 Indirect read velocity override:

Select the output value of the motor potentiometer G373 as the source for the velocity override.
= The output value of the motor potentiometer serves as the source for the velocity override.

= The velocity override can be provided as a set value specification by accessing parameter G468.

For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J28.

7.1. J11 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. )28 Velocity override enable:

To apply the velocity override to the desired motion block, select 1: Active.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J51.

8.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

8.2. J51 Source velocity override:

Select 1: Parameter G468 as the source for the velocity override.

The output value of the motor potentiometer is used as the set value specification for the velocity override.
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Specifying the set torque/set force

To specify a set torque/force via the motor potentiometer, select its output value as the set value source for the motion

command.

1.

2.

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the Set torque/force, velocity bracketing: Data source wizard.

G470 Source torque/force reference:

Select 5: Indirect read parameter G814.

G814 Indirect read torque/force reference:

Select the output value of the motor potentiometer G373 as the source for the set torque/force.
= The output value of the motor potentiometer serves as the source for the set torque/force.

= The set torque/force can be provided as a set value specification by accessing parameter G471.

For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J32.

7.1. J11 Command:

Select the 9: MC_TorqueControl motion command.

7.2. 132 Source reference torque/force:

Select 1: Parameter G471 as the source for the set torque/force.
For the command operating mode, parameterize the motion command and set value source via parameter J40.

8.1. J40 Command:

Select the 9: MC_TorqueControl motion command.

= The parameterized set value source is applied automatically; no further settings are necessary.

The output value of the motor potentiometer serves as the set value specification for the set torque/force.
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6.1.6.3 Additional fieldbus-controlled analog output function

In Drive Based Synchronous type applications, the additional fieldbus-controlled analog output function allows you to
control the respective analog output directly via a controller, e.g. for operating simple actuators such as pumps, fans, or
valves. The additional function can be used to specify an individual set value for each analog output (enable: G303; set
value: G306, G309). When fieldbus communication is active, the set value point is written by the controller via the process
data mapping (G304, G307). In addition, a fallback value can be defined which supplies the set value at the respective
analog output if fieldbus communication fails (G305, G308).

6.1.6.3.1 Parameterizing a fieldbus-controlled analogue output

To parameterize the additional function for controlling analog outputs via fieldbus, proceed as described below.

Information

To use the additional function for controlling the analog outputs via fieldbus, expand the process data mapping of the
application, depending on the fieldbus used. Further information on process data mapping can be found in the relevant
fieldbus manual.

Parameterizing fieldbus-controlled analogue output AO1

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Synchronous application wizard > Additional functions.

3. Activate the Fieldbus-controlled analog output 1 option.

= The additional function is activated and the associated wizard is displayed.
4. Select the Drive Based Synchronous application wizard > Additional functions > Fieldbus-controlled analog output 1.

5. G305 Set value AO1 fallback:

Define the fallback value used to control the analog output if fieldbus communication fails.
6. Select the Terminals wizard > Analog output 1.

6.1. F40 AO1 source:

For set value specification via fieldbus, select parameter G306 as the source for analog output AO1.

6.2. F41 AO1 reference value source:

If necessary, delete the reference value of analog output AO1.
7. For fieldbus communication via CANopen, add parameter G304 to the receive process data RxPDO A225 — A228.

8. For fieldbus communication via EtherCAT, add parameter G304 to the receive process data RxPDO A225 — A228 and

create a new ESl file for the controller if necessary.

9. For fieldbus communication via PROFINET, add parameter G304 to the receive process data RxPZD A90 — A91.
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Parameterizing fieldbus-controlled analogue output AO2

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

Select the Drive Based Synchronous application wizard > Additional functions.

Activate the Fieldbus-controlled analog output 2 option.
= The additional function is activated and the associated wizard is displayed.

Select the Drive Based Synchronous application wizard > Additional functions > Fieldbus-controlled analog output 2.

G308 Set value AO2 fallback:

Define the fallback value used to control the analog output if fieldbus communication fails.
Select the Terminals wizard > Analog output 2.

6.1. F50 AO2 source:

For set value specification via fieldbus, select parameter G309 as the source for analog output AO2.

6.2. F51 AO2 reference value source:

If necessary, delete the reference value of analog output AO2.
For fieldbus communication via CANopen, add parameter G307 to the receive process data RxPDO A225 — A228.

For fieldbus communication via EtherCAT, add parameter G307 to the receive process data RxPDO A225 — A228 and

create a new ESI file for the controller if necessary.

For fieldbus communication via PROFINET, add parameter G304 to the receive process data RxPZD A90 — A91.
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6.1.6.4 Additional phasing function

In Drive Based Synchronous applications, the additional phasing function allows you to make corrections to the master
position while the slave axis is coupled to the master. For example, the additional phasing function can be used if position-
based coupling of the slave axis via 14: MC_GearInPosition is not possible or to correct the master value of slave axes if
slipping occurs in the master.

Function

Phasing takes place within the slave axis. The slave axis receives the master position according to the selected master value
source (source: G27). In order to influence the position of the slave axis, a phase shift to the received master position is
specified by the set position of the phasing (set position: G223). The phase shift is added to the received master position
(total master position: G80).

The slave axis attempts to compensate for the phase shift by accelerating or decelerating. The compensation movement
has its own motion profile, which can be limited in terms of velocity, acceleration and jerk as well as permitted direction of
motion (motion profile: G224 — G227; limitation: G70 — G73). The compensation movement can therefore be executed
while the slave axis is coupled to the master.

Phasing can be started either via the digital inputs of the drive controller or via fieldbus (source: G230). The phase shift is
maintained until a new set position is specified by another phasing command. The phase shift can be executed with an
absolute set position or a set position relative to the existing phase shift, i.e. to the actual position of the phasing at the
start of the command (motion command: G234; actual position: G214).

\J

vA

[

\j

Execute T
i N _

Done T
[ L _

Fig. 13: Additional phasing function: Example

The example shows a phasing compensation movement with motion command G234 = 2: MC_MoveRelative. When the
Execute signal is triggered, the slave axis accelerates or decelerates according to the parameterized motion profile in order
to compensate for the phase shift specified via G223. The difference between the master position received (source: G27)
and the master position G80 of the slave axis used for motion commands corresponds to G214.

To ensure that the axis interrupts the active phasing motion command during the compensation movement, a separate
quick stop can be parameterized for the phasing (quick stop: G74, G216).

A preset function is available for phasing (preset: G78, G79, G240) in order to set the slave axis to a specific position
immediately and without a motion profile when decoupled.
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Application example

You are using a controller and operating the Drive Based Synchronous application in command operating mode. The master
position is measured using a measuring wheel that is in frictional contact with a material web, i.e. a master encoder is
acting as the master value source for the slave axes. There are print marks at regular intervals on the material web, e.g.
plastic film, which can be measured using a sensor. If slipping occurs and the measuring wheel briefly loses frictional
contact with the material web, the controller can detect this using the print marks and compensate for it with the help of
phasing.

6.1.6.4.1 Parameterizing phasing

For phasing, parameterize the limiting values and the source for the Execute signal as described below. The
parameterization of the quick stop and preset function is optional.

Information

To be able to control the additional phasing function via fieldbus, expand the process data mapping using the respective
wizard (EtherCAT: Received process data RxPDO; PROFINET: Received process data RxPZD).

An overview of the phasing parameters that can be written by the controller via fieldbus is provided by the Command
operating mode: Phasing wizard. Add the required parameters to both the receive process data of the drive controller and
the transmit process data of the controller (motion command: G234; set value specifications: G223 — G227; control word:
G10).

Parameterizing phasing
Parameterize the additional phasing function as described below.
v" You have completed the parameterization of synchronous operation.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing > Limit: Phasing.

3. G73 Phasing permitted direction:
If you selected 1: Endless for G30 when configuring synchronous operation, define the permitted direction of motion
for phasing.

3.1. If motions in both directions are permitted, select 0: Positive and negative.
3.2. If motions are only permitted in one direction, select 1: Positive or 2: Negative accordingly.

4. G70 Phasing maximum velocity:

Define the maximum permitted velocity for phasing.

5. G71 Phasing maximum acceleration:

Define the maximum permitted acceleration for phasing.

6. G72 Phasing maximum jerk:

Define the maximum permitted jerk for phasing.
7. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

8. G230 Source phasing execute:

Select the source for the digital signal that is used to start a motion command for phasing.
8.1. If a control unit is used as the source, select 2: Parameter.

8.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
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Phasing: Parameterizing a quick stop
To interrupt an active phasing motion command with a quick stop, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing.

3. G216 Phasing quick stop additional cause:
Select the device state of the drive controller that is to be an additional cause for triggering a quick stop during
phasing.

3.1. To trigger a quick stop when the axis has a fault, select 1: Error.
3.2. To trigger a quick stop when the axis is not enabled, select 2: Enable.
3.3. Totrigger a quick stop when the axis is not enabled or has a fault, select 3: Enable or error.
4. Select the Drive Based Synchronous application wizard > Additional functions > Phasing > Limit: Phasing.

5. G74 Phasing quick stop deceleration:
Define the delay for the quick stop of the phasing.

Phasing: Parameterizing a preset

To use the phasing preset function, proceed as described below.

/A WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

= Only execute this function if there are no slave axes coupled with the master.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing.

3. G78 Phasing preset position:
Define the set position for the phasing preset.

4. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

5. G240 Source phasing preset:
Select the source for the digital signal that is used to set the axis to the preset phasing position immediately and
without a motion profile.
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6.2 Synchronous operation - Concept

In DriveControlSuite, you have various options for parameterizing synchronous operation, which differ in terms of the
master value source and number of axes involved.

For example, you can use a virtual master as a master value source and provide the master value via the master axis model
to optimize the synchronism of multiple axes (example: smooth motion of a platform). Using a master encoder as a master
value source enables you to synchronize the motion of one or more axes with an upstream machine (example:
synchronizing conveyor belts). Using the actual position of the master axis as a master value allows you to synchronize slave
axes to a main axis.

6.2.1 Model 1: Virtual master or master encoder, multiple slave axes
Master Slave
Slave axis Slave axis

—_——
IrOF

y
e~

—

Motor axis Motor axis
model model

Fig. 14: Synchronous operation: Model 1

In this model, a virtual master or a master encoder acts as the master value source. Via the SSI motion bus, the master axis
follows the master value as a slave and provides additional slave axes to the master axis models across all devices.

This model for the configuration of synchronous operation allows you to synchronize the motion of multiple axes to a
common master value of a virtual master or to the master encoder of an upstream machine, for example.
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6.2.2 Model 2: Master encoder, individual slave axis

Master

Slave axis

Motor axis
model

!

Fig. 15: Synchronous operation: Model 2
In this model, a master encoder acts as the master value source. An individual axis follows the master value that is provided
by an internal device master axis model. Additional slave axes or an SSI motion bus do not have to be parameterized.

This model for the configuration of synchronous operation allows you to synchronize the motion of a single axis to the
master encoder of an upstream machine, for example.
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6.2.3 Model 3: Master axis, one or more slave axes
Master Slave
Master axis Slave axis
SSI
Motor axis Motor axis
model model

l

!

Fig. 16: Synchronous operation: Model 3

In this model, the actual position of the master axis acts as the master value. Via the SSI motion bus, the master axis
provides the master value to the master axis models of additional slave axes across all devices.

This model for the configuration of synchronous operation allows you to synchronize slave axes to the actual position of the

master axis, for example.
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6.3 SSI motion bus

The SSI motion bus enables multiple drive controllers from the SB6 series to access the position of a real or simulated
encoder as a master value for synchronous operation. The position value is synchronized every millisecond via SSI motion
bus and transmitted cyclically and in real time.

Application cases

The SSI motion bus enables access to a common master value for the position for synchronous operation of up to 8 drive
controllers from the SB6 series.

System requirements
= Atleast 2 and up to 8 drive controllers can be networked with each other
= All drive controllers must be directly connected to each other and the SSI motion bus must follow a line topology
= Encoder connection X120 is only available via terminal module XB6

= The use of the TTL connection cable X120 (ID no. 49482) is a prerequisite for a functioning network

Features

You can connect up to 8 drive controllers to each other via the X120A or X120B connections using the SSI motion bus. The
SSI motion bus makes the position signal of a real or simulated SSI encoder available to the drive controllers. Via the SSI
motion bus, 1 drive controller specifies an SSI clock, in whose rhythm a real or simulated encoder provides position bits that
are read by the SSI motion bus nodes.

Synchronous operation via SSI motion bus eliminates the need for complex fieldbus configuration. Synchronous operation
via SSI motion bus is also possible if synchronization via EtherCAT or PROFINET IRT is configured.

Information

When using the X120A and X120B double interface as an SSI motion bus, all nodes must be switched on or off
simultaneously (24 V supply at terminal X11 and at terminal X101, pin 6). Switching individual nodes in operation can lead
to faults for other nodes (event 77: Master encoder, cause 30: X120 wire break).
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6.3.1

SSI motion bus at X120 with free setting (H120 = 76 or 83)

Alongside evaluating and simulating encoders, an SSI motion bus with maximum 8 nodes can be set up via connections

X120A and X120B. The SSI motion bus is used to make the position signal of a real or simulated SSI encoder available to

multiple drive controllers. Synchronous operation via SSI motion bus is also possible if synchronization via EtherCAT or

PROFINET IRT is configured.

Depending on the required function of the drive controller within the SSI motion bus, different settings are required in the

DriveControlSuite.

SSI motion bus with real encoder

Drive Parameters | Description
controller

Role

1 H120
2-8

1-8 H134
1-8 H137
1-8 H121
1-8 H122

Data bit

Monoflop time

Mechanical
value

Raw encoder
value

Rotational single-turn
encoder

76: SSl free setting
68: SSI passive

Sum of single-turn bits
+ alarm bits, if any

10-100 ps

1 rotation

2Number of single-turn bits

Tab. 5: SSI motion bus with real encoder on X120 with free setting

SSI motion bus with simulated encoder

Drive Parameters | Description
controller

1 H120
1 H80
2 H120
3-8

1-8 H134
2-8 H137
2-8 H121
2-8 H122

Role

Source of the
simulated
position

Role

Data bit

Monoflop time

Mechanical
value

Raw encoder
value

83: SSI simulation free
setting

E.g.: 5: Motor position
(E09)

76: SSlI free setting
68: SSI passive

Sum of single-turn bits

15 ps

1 rotation

ZNumber of single-turn bits

Tab. 6: SSI motion bus with simulated encoder on X120 with free setting

Value

76: SSl free setting
68: SSI passive

Sum of single-turn bits
+ multi-turn bits +
alarm bits, if any

10-100 ps

1 rotation

2Number of single-turn bits

Value

83: SSI simulation free
setting

E.g. 5: Motor position
(E09)

76: SSI free setting
68: SSI passive

Sum of single-turn bits
+ multi-turn bits

15 ps

1 rotation

2Number of single-turn bits

Rotational multi-turn Linear encoder
ncoder

76: SSl free setting
68: SSI passive

Sum of position bits +
alarm bits, if any

10-100 ps
Measuring range, e.g.

200 mm

Number of increments
of the measuring
range

Rotational single-turn | Rotational multi-turn | Linear encoder
encoder encoder

83: SSI simulation free
setting

E.g. 5: Motor position
(E09)

76: SSl free setting
68: SSI passive

Sum of position bits

15 ps
Measuring range, e.g.
200 mm

Number of increments
of the measuring
range
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Interpretation

The interpretation of the data bits as the position is carried out using the H121 and H122 parameters.

Relationship between resolution, clock frequency and double transmission in SSI encoders
Ideally, a new, valid position value in high resolution is available in every cycle of the control.

With a higher resolution of the position value, the amount of data to be transmitted (H134) increases and thus so does the
transmission time. The same applies if the position is read out twice to enable better detection of transmission errors
(H128) for increasing data security.

The transmission time of the position value should not exceed the cycle time of the control. To compensate for the
increased transmission time, you can transmit the bits at a higher clock frequency (H135) if the SSI encoder supports this
function. From approx. 600 kHz, cable lengths of 100 m are no longer possible.

106

10/2025 | ID 443501.00



10/2025 | ID 443501.00

STOBER

6 | More on Drive Based Synchronous?

6.4 Axis model

With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

With 105 Type of axis, you select a rotational or a translational axis model and define whether the scaling of the axis is done
using either predefined or individually configured units of measure. With 100 Position range, you parameterize either an
endless (modulo) or a limited travel range. You parameterize the encoder arrangement by using B26 Motor encoder and
102 Position encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

LinM Linear Motor

M Motor

MEnc Motor Encoder
PEnc Position Encoder

Rotational axis models

The following figures each show a rotational axis model consisting of a motor, a gearbox and a rotary table (endless
rotational) or a pointer (limited rotational). Rotational axis models support rotational motor encoders as well as rotational

3

position encoders.

ny
= M,

Gear

Fig. 17: Endless-rotational motion: Rotary table
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D

ny
—

Gear

[\

Fig. 18: Limited-rotational motion: Pointer

Translational axis models

The following figures each show a translational axis model consisting of a motor, gearbox, feed and conveyor belt (endless
translational) or tool slide (limited translational). Translational axis models support rotational motor encoders as well as
rotational or translational position encoders.

+“—>

_1m _1n

— /n,F p— <

Gear Feed
Fig. 19: Endless translational motion: Conveyor belt

+—>

S Lt - _In

ol n,[ ] X —— AN A\ A

Gear Feed

Fig. 20: Limited translational motion: Tool slide

Translational axis model: Linear motor

The following figure shows a limited translation axis model using the example of a linear motor. Linear motors only support
translational motor encoders and translational position encoders.

+“—>
LinM
B |
PRI I T AT I A A A
MEnc/PEnc

Fig. 21: Limited translational motion: Linear motor
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Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and 102 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gearbox output. If
you use only one of the two encoders, it will be used for both velocity and position control.

Encoder Parameterization Encoder arrangement

Motor encoder B26 # 0: Inactive ®:®: n,
102 = 0: Motor encoder n.

MEnc  Gear un

Position encoder B26 # 0: Inactive @: n,
102 = B26 >

Gear unit  PEnc

Motor encoder & position B26 # 0: Inactive ®:®: n, ( )
encoder 102 # B26 n,

MEnc  Gear unit PEnc

%FHH
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6.5 Limit switches

With limit switches, you can secure the travel range by selecting the respective end of the travel range and thus limiting the
permitted positions of the axis. Hardware limit switches and software limit switches are available to limit the travel range.
Hardware and software limit switches can be used individually or in combination with each other.

Hardware limit switches are physical sensors (hardware) that are triggered when a certain position is reached, while
software limit switches are purely software-implemented functions for position limiting that are only available when the
travel range is limited (100 = O: Limited).

Function

When a limit switch is overshot, event 53: Limit switch is triggered and the axis goes into a fault condition with or without a
quick stop, depending on the parameterization. As soon as a limit switch is triggered, the motion core interrupts the current
motion command and refuses further commands in the same direction of motion. The direction lock ensures that the axis
can only move away from the limit switch in the opposite direction and return to the permitted travel range. As soon as the
direction lock is deactivated, event 53: Limit switch can be triggered again.

Further information on event 53: Limit switch, possible causes and actions can be found in the drive controller manual (see
Further information [P 156]).

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

= Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

Restriction of the direction of motion

With an endless travel range, a direction lock can also be triggered by a positioning command outside the revolution length
or by restricting the direction of motion using 104 (travel range: 100 = 1: Endless; revolution length: 101; permitted direction:
104). A restriction of the direction of motion is also indicated in the operating state of the axis (operating state: E80Q).

Since restricting the direction of motion using 104 prevents the hardware limit switch from moving in the opposite direction
of motion, it is generally not advisable to combine the two functions.
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6.5.1 Hardware limit switches

Hardware limit switches can be used for both limited and endless travel ranges (travel range: 100). A digital input or a

fieldbus can serve as the source for the digital signal for evaluating the respective hardware limit switch (source: 1101, 1102).

The digital signals for evaluating the hardware limit switches are low-active (normally closed contact), i.e. the limit switch is
triggered when the digital signal is interrupted (signal: 1441, 1442 = 0: Inactive). Ensure that the hardware limit switches and,
if necessary, the controller are connected correctly to prevent false triggering of event 53: Limit switch.

Relevant parameters
= |101 Source positive /limit switch
= ]102 Source negative /limit switch
= 1441 Signal /HW limit switch positive
= 1442 Signal /HW limit switch negative
= 1805 Actual value HW-Limit switch positive
= 1806 Actual value HW-Limit switch negative
= |52 Delete limit switch memory

= 1196 Direction blocking

Normal operation
When a hardware limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.
Causes

= 1:Hardware-Limit-Switch positive (prerequisite: 1441 = 0: Inactive)

= 2:Hardware-Limit-Switch negative (prerequisite: 1442 = 0: Inactive)

A hardware limit switch is triggered when the digital signal for evaluating the hardware limit switches is interrupted. The
motion core interrupts the current motion command and refuses further commands in the same direction of motion; a
direction lock becomes active (denial: 191 = 1: Active; cause: 190; direction lock: 1196).

The direction lock is deactivated as soon as the limit switch memory is reset.

Jog mode

With hardware limit switches, the behavior of the axis is independent of the control type selected for jog mode (126). When
a hardware limit switch is overshot, the axis behaves the same way in jog mode as in normal operation.

Referencing

During referencing, hardware limit switches can be evaluated like reference switches by using the corresponding
referencing type (referencing type: 130 = 2: Limit switch; referencing methods: A, C, E, G).

With other referencing types, a triggered hardware limit switch reverses the direction of motion if the limit switch matches
the direction of motion (e.g. positive limit switch and positive direction of motion). If a triggered hardware limit switch does
not match the direction of motion, fault 53: Limit switch is triggered (e.g. positive limit switch with negative direction of
motion).

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.

111



6 | More on Drive Based Synchronous? STOBER

Limit switch memory

When a hardware limit switch is overshot, the position of the limit switch is saved internally and the triggered limit switch is
recorded as active in the limit switch memory as long as the axis is at or past the limit switch (limit switch memory: 1805,
1806). Based on the stored position of the limit switch and the digital signals for evaluating the hardware limit switches, the
limit switch memory is automatically reset in normal operation as soon as the axis has returned to the permitted travel
range.

HW limit switch negative HW limit switch positive
: Permitted travel range
|
I
|

1442

1806

1441

1805

A
\

Position of the axis

1 3
- E—
2 4
— 47

Fig. 22: Hardware limit switch: Limit switch memory

1 Negative HW limit switch triggered, limit switch memory set
2 Negative HW limit switch exited, limit switch memory reset
3 Positive HW limit switch triggered, limit switch memory set
4

Positive HW limit switch exited, limit switch memory reset
Example

A positive hardware limit switch ranges from position 100 to 120; when moving in the positive direction of motion, it is
triggered at position 100 (signal: 1441 = 1: Active - 0: Inactive). On the return journey, the tolerance may cause the real
hardware limit switch to be left at position 101 (signal: 1441 = 0: Inactive - 1: Active). However, in order for the effective
limit switch or limit switch memory to be reset, position 100 must be reached or undershot.

The position of the limit switch is not stored in non-volatile memory, i.e. if the axis is outside the limit switches after
switching on, it must first be moved back into the permitted travel range.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter 152. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using 1452 or by
restarting the drive controller.

Controller start-up

If a controller is used as the source for the digital signals for evaluating the hardware limit switches and this is still in device
start-up while the drive controller and fieldbus communication are already active, event 53: Limit switch is triggered (cause:
7: Both limit switches not connected) and the limit switch memory is set (1805, 1806 = 1: Active).

If the power unit has not yet been enabled since the supply voltage was switched on, the limit switch memory is
automatically reset as soon as the controller correctly transmits the signals for evaluating the hardware limit switches.
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6.5.2 Software limit switches

Software limit switches are only available with a limited travel range (100 = 0: Limited). To be able to check the actual
position of the axis using software limit switches, the axis must be referenced.

The position of the negative software limit switch must be a smaller value than the position of the positive software limit
switch. If the same value is defined for both software limit switches, the function is deactivated.

Relevant parameters
= |50 Software stop positive: Highest permitted position
= |51 Software stop negative: Lowest permissible position
= |22 Target window
= |80 Current position

= 1196 Direction blocking

Normal operation
When a software limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.
Causes

= 3: SW-limit switch positive (prerequisite: 180 > 150 + 122)

= 4: SW-limit switch negative (prerequisite: 180 < 151 —122)

A software limit switch is triggered if the actual position of the axis is outside the permitted travel range, taking the position
window into account. The motion core interrupts the current motion command and refuses further commands in the same
direction of motion; a direction lock becomes active (denial: 191 = 1: Active; cause: 190; direction lock: 1196).

The direction lock is deactivated as soon as the actual position of the axis is back within the permitted travel range, taking
the position window into account.

Jog mode
With software limit switches, the behavior of the axis depends on the control type selected for jog mode (126).

If 126 = 0: Velocity control, a quick stop is triggered instead of a fault reaction when a software limit switch is overshot in jog
mode, so that the axis comes to a standstill outside the permitted travel range depending on the quick stop deceleration
(deceleration: 117). The direction lock ensures that the axis can only move away from the limit switch in the opposite
direction and return to the permitted travel range.

When 126 = 1: Position control and the set position is outside the permitted travel range, the axis is braked with jog
deceleration and tip jerk so that the axis still comes to a standstill within the permitted travel range shortly before the
software limit switch (deceleration: 145; jerk: 118).

Referencing

Software limit switches are not evaluated during referencing (motion command 1401 = 6: MC_Home).
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6.5.3 Virtual master

The position of the virtual master can be limited via software limit switches if the master axis model is limited (prerequisite:
G30 = 0: Limited). To be able to check the actual position of the virtual master using software limit switches, the virtual
master does not need to be referenced.

The position of the negative software limit switch must be smaller than the position of the positive software limit switch of
the virtual master. If the same value is defined for both software limit switches of the virtual master, the function will be
deactivated.

Relevant parameters
= G146 Virtual master software limit switch +
= G147 Virtual master software limit switch -
= G161 Virtual master error
= G163 Virtual master error cause

= (G190 Actual position virtual master

Normal operation

If a software limit switch of the virtual master is overshot, event 51: Virtual master software limit switch with fault reaction
is triggered (prerequisite: U24 = 3: Fault).

Causes
= 1: SW-limit switch positive (prerequisite: G190 > G146)
= 2: SW-limit switch negative (prerequisite: G190 < G147)

A software limit switch of the virtual master is triggered if the actual position of the virtual master is outside the position
range defined as permitted. The motion core of the virtual master cancels the current motion command and refuses further
commands in the same direction of motion (denial: G161 = 1: Active; cause: G163).

The direction lock ensures that the virtual master can only move away from the limit switch in the opposite direction of
motion and return to the permitted travel range. As soon as the actual position of the virtual master is within the permitted
travel range again, the fault can be triggered again (G147 < G190 < G146).

Information

In order to trigger the quick stop of the virtual master when event 51: Virtual master software limit switch occurs, the level
of the associated protective function must be selected accordingly (U24 = 3: Fault) and the axis fault must be defined as an
additional quick-stop cause for the virtual master (G57 = 1: Error/3: Enable or error).

To trigger the quick stop of the virtual master when event 51: Virtual master software limit switch occurs, proceed as
described in Parameterizing the virtual master [P 34].
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6.6 Referencing

To be able to work with a system with absolute positions, the relation of a measured axis position to an actual axis position
must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary. As a rule, this is either identified through a reference search or referencing setting. The associated

process is referred to as referencing.

Absolute movements can be performed only in a referenced state. For relative movements, referencing is only required if
the software limit switch function is used at the same time.

When replacing a drive controller, the reference can be transferred to the replacement drive controller via an SD card. The
information is also saved on the SD card if the action AOO Save values is executed for the referenced axis. For more
information on replacing a drive controller, refer to the manual for the respective drive controller.

6.6.1 Referencing methods

The following table shows an overview of the possible referencing methods.

S Switch
M/F Torque or force
I = )
movement
A Negative Negative limit switch
B Negative Yes Negatively positioned reference switch
C Negative - Negative limit switch
D Negative - Negatively positioned reference switch
—> E Positive Yes Positive limit switch
I F Positive Yes Positively positioned reference switch
Positive - Positive limit switch
H Positive - Positively positioned reference switch
| Positive Yes Centrally positioned reference switch
J Positive - Centrally positioned reference switch
K Negative Yes Centrally positioned reference switch

M Negative Yes Zero pulse

N Positive Yes Zero pulse

(e} - - Setting the reference

I
-
H L Negative - Centrally positioned reference switch
]
[
]

g § @

TTTTTI

M/F —> P Positive - Torque/force stop

Q Positive Yes Torque/force stop

<«— M/F R Negative - Torque/force stop
I S Negative Yes Torque/force stop

Tab. 7: Referencing methods
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6.6.1.1 Referencing methods in detail
The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse
Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

128 Homing torque/force limit
129 Time homing torque/force limit
130 Referencing type

131 Referencing direction

132 Referencing speed fast

133 Referencing speed slow

134 Reference position

135 Referencing with zero pulse
139 Referencing acceleration

143 Move to reference position
144 Referencing jerk

153 Index search offset

1101 Source positive /limit switch
1102 Source negative /limit switch
1103 Source reference switch
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6.6.1.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS- LS+

/

1

Preparation

1.

Activate referencing method A by setting the following parameters to the specified values:
130 to 2: Limit switch,

131 to 1: Negative,

135 to 1: Active.

1102:

Enter the data source for the negative limit switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the negative limit switch and continues its run with velocity 133 until it reaches

the next zero pulse after leaving the limit switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.
I = 1

ALT 1 /

N

ALT 2

s i

zp |

RS

Preparation

1. Activate referencing method B by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to 1: Negative,
135 to 1: Active.

2. 1103:

Enter the data source for the reference switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

4. 153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive is positioned in front of the reference switch
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration 139.
5. If143is set to 1: Active, the drive is positioned at reference position 134.
v' Alternative 2: Drive stopped at reference switch
1. The drive starts in the positive direction with acceleration 139 and velocity 133.
2. It changes its direction upon reaching the reference switch and continues its run with velocity 132.

3.  When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133

until it reaches the zero pulse.
4. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
5. The drive comes to a standstill with deceleration 139.

6. If143is setto 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS- LS+

/

1

LS- |

Preparation

1. Activate referencing method C by setting the following parameters to the specified values:
130 to 2: Limit switch,
131 to 1: Negative,
135 to 0: Inactive.

2. 1102:

Enter the data source for the negative limit switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity 133 until it leaves

the limit switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the limit switch.
4. The drive comes to a standstill with deceleration [39.

5. If143is setto 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

ALT 2

—

ALT1

Preparation

1.

Activate referencing method D by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to 1: Negative,

135 to 0: Inactive.

1103:

Enter the data source for the reference switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

v" Alternative 1: Drive is positioned in front of the reference switch

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 2: Drive stopped at reference switch
The drive starts with acceleration 139 and velocity 133 in the positive direction until it leaves the reference switch.
It changes its direction upon leaving the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133

until it reaches the reference switch again.
The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

P

LS+

LS- LS+

Y

-
/

Preparation

1.

Activate referencing method E by setting the following parameters to the specified values:
130 to 2: Limit switch,

131 to O: Positive,

135 to 1: Active.

1101:

Enter the data source for the positive limit switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the positive limit switch and continues its run with velocity 133 until it reaches

the next zero pulse after leaving the limit switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

ALT 1

ALT 2

ZP

RS

—

I N
-fd
N

Preparation

1.

Activate referencing method F by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to O: Positive,

135 to 1: Active.

1103:

Enter the data source for the reference switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

v' Alternative 1: Drive is positioned in front of the reference switch

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.

The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 2: Drive stopped at reference switch

The drive starts in the negative direction with acceleration 139 and velocity 133.

It changes its direction upon reaching the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133

until it reaches the zero pulse.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS- LS+

-
/

Y

{i/

LS+

Preparation

1. Activate referencing method G by setting the following parameters to the specified values:

130 to 2: Limit switch,
131 to O: Positive,
135 to O: Inactive.

2. 1101:

Enter the data source for the positive limit switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity 133 until it leaves the

limit switch again.

3. The current actual position is set to the value of the reference position 134 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration 139.

5. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

= ' = ]

ALT1 ¥ >

f X/
AN |
ALT 2 \ 4 A

|

RS

Preparation

1. Activate referencing method H by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to O0: Positive,
135 to 0: Inactive.

2. 1103:

Enter the data source for the reference switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.
v" Alternative 1: Drive is positioned in front of the reference switch
1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration 139.

5. Ifl43isset to 1: Active, the drive is positioned at reference position 134.

v' Alternative 2: Drive stopped at reference switch
1. The drive starts with acceleration 139 and velocity 133 in the negative direction until it leaves the reference switch.
2. It changes its direction upon leaving the reference switch and continues its run with velocity 132.

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133

until it reaches the reference switch again.
4. The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
5. The drive comes to a standstill with deceleration 139.

6. If143is setto 1: Active, the drive is positioned at reference position 134.
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6.6.1

Refer

1.9 Referencing method |

encing method | determines the reference using a run to the centered reference switch and zero pulse.

LS= RS LS+

ALT1

ALT 2

ALT 3

ZP

RS
LS+

Preparation

1.

Activate referencing method | by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to O: Positive,

135 to 1: Active.

1103:

Enter the data source for the reference switch.

132,133,139, 144, 134:
Define the set values necessary for referencing.

153:
Define the start of the search for the zero pulse search

Referencing

If the

v

1.

2.

PLCopen command MC_Home is active, a distinction is made between three referencing sequences.
Alternative 1: Drive is positioned between the negative limit and reference switches
The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 133.
It changes its direction upon reaching the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133

until it reaches the zero pulse.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 3: Drive is positioned between the reference and positive limit switches

The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the positive limit switch until the reference switch is reached.

Upon reaching the reference switch, the drive changes its velocity to 133 until it leaves the reference switch again.

The current actual position is set to the value of the reference position 134 after leaving the reference switch and upon

reaching the next zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.10 Referencing method J
Referencing method J determines the reference using a run to the centered reference switch.
LS- [ RS | LS+
-w— —
T : :
1 1
1 1 I
1 1 1
i | i
ALT 1 . x> | |
1 1 1
i | i
1 1 I
1 : :
AT > / s ;
i | i
1 1 1
1 1
1 1 1
1 1 1
| | /——>—:r\
e N - B /
1 1 1
1 1 1
! <
1 1 I
1 1 1
1 1 1
l i
RS ;
1
L5+ L

Preparation

1. Activate referencing method J by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to O: Positive,
135 to O: Inactive.
2. 1103:
Enter the data source for the reference switch.
3. 132,133,139, 144, I34:
Define the set values necessary for referencing.
Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.
v' Alternative 1: Drive is positioned between the negative limit and reference switches
1. Thedrive starts in the positive direction with acceleration 139 and velocity 132.
2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the
reference switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration 139.
5. If143is setto 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 133.

It changes its direction upon reaching the reference switch and continues its run with velocity 132 until it leaves the
reference switch.

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133
until it reaches the reference switch again.

The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 3: Drive is positioned between the reference and positive limit switches
The drive starts in the positive direction with acceleration 139 and velocity 132.

Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the

reference switch.

Upon reaching the reference switch, the drive changes its velocity to 133 until it leaves the reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.11 Referencing method K
Referencing method K determines the reference using a run to the centered reference switch and zero pulse.
LS- [ RS | LS+
] 1 ]
T T T
i i —a
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Preparation

1.

Activate referencing method K by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to 1: Negative,

135 to 1: Active.

1103:

Enter the data source for the reference switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search

Referencing

If the

v

1.

2.

PLCopen command MC_Home is active, a distinction is made between three referencing variants.

Alternative 1: Drive is positioned between the reference and positive limit switches
The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 133.
It changes its direction upon reaching the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133
until it reaches the zero pulse.

The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 3: Drive is positioned between the negative limit and reference switches
The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

Upon reaching the reference switch, the drive changes its velocity to 133 and continues its run until it reaches the next

zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.

LS= RS LS+

ALT 1

¢

ALT 2

ALT3 < '
|
]

RS

LS-

Preparation

1. Activate referencing method L by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to 1: Negative,
135 to 0: Inactive.

2. 1103:

Enter the data source for the reference switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.
v' Alternative 1: Drive is positioned between the reference and positive limit switches
1. Thedrive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration 139.

5. If143is setto 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts with acceleration 139 and velocity 133 in the positive direction until it leaves the reference switch.
It changes its direction upon leaving the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133

until it reaches the reference switch again.
The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 3: Drive is positioned between the negative limit and reference switches
The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

When the reference switch is reached, the drive changes its velocity to 133 and continues its run until it leaves the

reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.13 Referencing method M

This method determines the reference using a run to the zero pulse.

P

N
|

Preparation

1. Activate referencing method M by setting the following parameters to the specified values:
130 to 3: Zero pulse,
131 to 1: Negative,
2. 132,139, 144, 134:
Define the set values necessary for the referencing.
Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 132.

The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

6.6.1.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

ZP

4 A

Preparation

1.

Activate referencing method N by setting the following parameters to the specified values:
130 to 3: Zero pulse,
131 to O: Positive,

2. 132,139, 144, 134:
Define the set values necessary for the referencing.
Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 132.

The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

i - i

Preparation

1. 130:

Activate referencing method O by setting this parameter to 5: Define home.

2. 134:
Define the reference position.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position 134.

6.6.1.1.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

[ w 1
/ |

Y

Preparation

1. Activate referencing method P by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,
131 to O: Positive,
135 to O: Inactive.

2. 132,139, 144, 134:
Define the set values necessary for the referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. The current actual position is set to the value of the reference position 134 when the torque/force limit is reached and

the time stored in 129 has elapsed.
3. The set values are set to the value 0 with deceleration 139.

4. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1

117 Referencing method Q

Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

Y

w
-

ZP

Preparation

1.

Activate referencing method Q by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,

131 to 0: Positive,

135 to 1: Active.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

153:

Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value

that is too small, an incorrect reference position may be applied.

Referencing

If the

1.

2.

PLCopen command MC_Home is active, referencing takes places as follows:
The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the torque/force stop and when the time stored in 129 has passed, and

continues its run with velocity 133 until it reaches the next zero pulse.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The set values are set to the value 0 with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

I - I
| /'

Preparation

1

1. Activate referencing method R by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,
131 to 1: Negative,
135 to 0: Inactive.

2. 132,133,139, 144, 134:

Define the set values necessary for referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. The current actual position is set to the value of the reference position 134 when the torque/force stop is reached and

the time stored in 129 has elapsed.
3. The set values are set to the value 0 with deceleration 139.

4. Ifl43isset to 1: Active, the drive is positioned at reference position 134.
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6.6.1.1.19 Referencing method S

Referencing method S determines the reference using a run with torque/force stop and zero pulse.

ZP

w
/

1

Preparation

1.

Activate referencing method S by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,

131 to 1: Negative,

135 to 1: Active.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

153:

Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration 139 and velocity 132.
2. It changes its direction upon reaching the torque/force stop and after the time stored in 129 has passed, and continues
its run with velocity 133 until it reaches the next zero pulse.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The set values are set to the value 0 with deceleration 139.
5. If143is setto 1: Active, the drive is positioned at reference position 134.
6.6.2 Reference position

Depending on the referencing type 130, the actual position 180 is replaced by the reference position 134 during the

referencing event.
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6.6.3 Reference retaining

STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (146) are offered.

6.6.4 Reference loss

Axis
In certain cases, an axis loses its reference, and its state changes from 186 = 1: Active to 186 = 0: Inactive.
Normal operation (axis)

During normal operation, encoder faults or actions can lead to a loss of the reference. If the reference was deleted by an
encoder event, it can subsequently be restored.

Information

Before restoring the reference, check the actual position displayed (180). If in doubt, do the referencing again. If relative
encoders are used or if the axis was still moving during the encoder fault, the actual position displayed may deviate from
the real actual position of the axis.

Event 76: Position encoder Encoder fault Actual position may still be correct, restoring the reference
is possible:

= Check the actual position (180).

= Confirm reference (1130) or re-reference axis

Event 37: Motor encoder Encoder fault When using the motor encoder as a position encoder
(102 = 0: Motor encoder), 2 faults are triggered (37: Motor
encoder and 76: Position encoder); in display parameter
E82 and in the fault memory it is possible that only one
fault is displayed.

Actual position may still be correct, restoring the reference
is possible:

= Check the actual position (180).

= Confirm reference (1130) or re-reference axis

Action 138 Deleted reference Action 138 deletes the reference but does not change the
actual position displayed.

Actual position may still be correct, restoring the reference
is not possible:

= Check the actual position (180).
= Reference the axis again

Tab. 8: Loss of reference of the axis in normal operation
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Parameter changes (axis)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the

reference.

Changing parameters Changed axis model Actual position is undefined if one of the following
parameters was changed:

B26 Motor encoder

C15 Gear rationl

C16 Gear ratio n2

C17 Feed constant numerator
C18 Feed constant denominator
100 Position range

101 Circular length

102 Position encoder

103 Axis polarity

105 Type of axis

107 Distance factor numerator position

108 Distance factor denominator position

It is not possible to restore the reference:

Reference the axis again

Changing parameters Changed encoder interface  Actual position is undefined if a parameter of the H group
was changed.

It is not possible to restore the reference:

Tab. 9: Reference loss of the axis due to parameter changes

Restarting the drive controller (axis)

Reference the axis again

Depending on the encoder type and method for reference retaining (146), the reference of a previously referenced axis is

restored or deleted after a restart.

By default (146 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if the axis was

referenced with this encoder. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in 146. In addition to the preset, the following further options are

available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention

window (148)

= Reference is retained regardless of the presence of an encoder

= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
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Special case of incorrect motor connection (axis)

If a motor is inadvertently connected to the incorrect axis or the incorrect drive controller, such as after a case of service,
the drive controller behaves as follows after it is switched on:

= The axis changes to the non-referenced state (186 = 0: Inactive)
= The actual position displayed is undefined

However, the information from the original motor and the associated reference data are stored in the drive controller.
After switching off the drive controller, connecting the correct motor and restarting the drive controller, the reference is
restored and the actual position is displayed correctly (prerequisites: multi-turn absolute encoder, referenced axis and
preset for reference retaining 146 = 0: Normal).

Master encoder
Actual positions of the master encoder are used in the Drive Based Synchronous application for synchronous operation.

In all applications except the Drive Based Center Winder application, the actual position of the master encoder can be used
to pass on the position of another encoder attached to the machine to the control system. The drive controller transfers the
position from the encoder interface to the respective fieldbus.

Master encoders behave in a similar way to position encoders. In certain cases, a master encoder loses its reference, and its
state changes from G89 = 1: Active to G89 = 0: Inactive.

Normal operation (master encoder)

During normal operation, encoder faults can lead to a loss of the reference.

Event 77: Master encoder Encoder fault Actual position of the master encoder is undefined, it is not
possible to restore the reference:

= Reference the master encoder again

Tab. 10: Reference loss of the master encoder in normal operation
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Parameter changes (master encoder)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Changing parameters Changed axis model Actual position of the master encoder is undefined if one of
the following parameters was changed:

= G30 Position range master
= G40 Circular length master
= G47 Distance factor numerator master
= G48 Distance factor denominator master
= (G104 Source master encoder
It is not possible to restore the reference:

= Reference the master encoder again

Changing parameters Changed encoder interface  Actual position of the master encoder is undefined if a
parameter of the H group was changed.

It is not possible to restore the reference:
= Reference the master encoder again

Tab. 11: Reference loss of the master encoder due to parameter changes

Restarting the drive controller (master encoder)

Depending on the encoder type and method for reference retaining (G35), the reference of a previously referenced master
encoder is restored or deleted after a restart.

By default (G35 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if this encoder was
used for referencing. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in G35. In addition to the preset, the following further options are
available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (148)

= Reference is retained regardless of the presence of an encoder

= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
Virtual master

By definition, the virtual master has no reference. Its actual position can be set directly to a value and used as a reference.
The reference is retained even after a restart.
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6.7 Drive Based device control

Drive Based device control is based on DRIVECOM profile drive technology 21; this profile describes the control sequence of
a drive controller based on a device state machine. Each device state here represents a certain behavior that can be
changed only through defined events. These events are assigned to individual state transitions.

Some of the conditions and responses coupled with the state transitions can be influenced specific to the user. For
example, it is possible to define the end of a quick stop or enable delays in a way that is tailored to the respective
application case (see wizard Drive Based device control).

The following chapters describe the device states and the possible state transitions associated with them. You will also
learn whether certain actions are necessary on your part to reach the individual device states, what those actions are and
which user-specific factors you can parameterize yourself.

6.7.1 Drive Based device state machine

The device state machine describes the different device states of the drive controller along with the possible state changes.

eee 14 . .
Fault reaction active

io 15

Not ready to switch on Faults
1
®e 1) Y 16
oo 13 Switch on disabled 10 ee
2 6e
\ 4
e 11 9 e
Ready to switch on
3 5e
Switched on
4
Operation enabled 8 Quick stop active

Fig. 23: Drive Based device state machine: device states and state changes

Priority levels are marked by dots. The more dots a state change has, the higher its priority. Accordingly, a state change
without any dots has the lowest priority.
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6.7.2 States, transitions and conditions

The states provided by Drive Based device control all have specific features. A state either transitions into another state

automatically or requires certain actions from the user. There are also transition conditions that you can parameterize to be

tailored to your application case using the Drive Based device control wizard.

Parameter E48 shows the current device state of a drive controller.

6.7.2.1 Key

The following terms are used in the descriptions of the states, transitions and conditions:

Enable active

Enable is inactive

Quick stop in case of Enable-off active
Quick stop in case of Enable-off inactive

Quick stop end

Quick stop duration expired
Autostart active

Autostart inactive

Additional enable signal is active (A300 = 1: Active, source: A60)
Additional enable signal is inactive (A300 = O: Inactive, source: A60)
Quick stop in case of Enable-off is active (A44 = 1: Active)

Quick stop in case of Enable-off is inactive (A44 = 0: Inactive)

Standstill reached (1199 = 1: Active)

OR

maximum quick stop duration has expired (A39)
OR

A45 = 1: No stop and quick stop request ist inactive

Maximum quick stop duration has expired (A39)
Autostart is active (A34 = 1: Active)

Autostart is inactive (A34 = 0: Inactive)

Tab. 12: States, transitions and conditions: Terms

6.7.2.2 Not ready to switch on

Features

= Drive controller and safety module are initialized and tested

= The power unit as well as drive and activation functions are locked

= Brakes remain engaged

Transition to Switch on disabled (1)

The drive controller switches to the Switch on disabled state automatically after initialization and successfully completing

the self-test (typically approx. 30 s).

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.7.2.3 Switch on disabled

Features
= |nitialization has been completed
= Self-test was successfully completed
= The power unit as well as drive and activation functions are locked
= Brakes remain engaged, release override can be requested with a rising edge
Possible causes of a switch-on lockout include:
1. Enable is active (A300) and Autostart is inactive (A34); cause only in the Switch on disabled state)
2. Insufficient or no supply voltage/DC link feed-in
3.  STO safety function is active

4. Release override is active (source: FO6; cause only in the Switch on disabled, Ready to switch on and Switched on

states)

5. Control panel or local operation is active (cause only in the Switch on disabled, Ready to switch on and Switched on

states)

For the exact cause of a switch-on lockout, refer to parameter E49.

Application-specific parameterization
A34 Auto start:

If this parameter is enabled, the drive controller switches directly to the Ready to switch on state in case of a pending
enable signal.

/A WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or machine in question permit a direct
switch to the Ready to switch on device state.

= Inaccordance with EN 61800-5-1, clearly mark an activated autostart on the system and in the associated system
documentation.

Transition to Ready to switch on (2)
Enable inactive AND no cause for a switch-on lockout
OR

Enable active AND Autostart active AND no cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.7.2.4 Ready to switch on

Features
= Power unit and drive function are disabled
= Drive controller is ready to switch on

= Brakes remain engaged, release override can be requested with a rising edge

Application-specific parameterization

In addition to the enable signal at terminal X1, the Drive Based device state machine also supports the use of an additional
enable signal, for example over a fieldbus or using digital inputs. The enable signal and additional enable signals are coupled
by an AND link. In this case, the drive controller is enabled only if the value of both signals is HIGH.

A60 Source additional enable:

If you are working with an additional enable signal, define the data source of the additional signal in this parameter. In the
case of a fieldbus connection, A180 bit 0 supplies the additional enable signal.

Transition to Switched on (3)

Enable active

Transition to Switch on disabled (6), priority: ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction

6.7.2.5 Switched on

Features
= Power unit is ready for operation
= Drive function is locked; set values are not processed

= Brakes remain engaged, release override can be requested with a rising edge

Transition to Operation enabled (4)

Enable active

Transition to Ready to switch on (5), priority: ®

Enable inactive

Transition to Switch on disabled (13), priority: ® ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.7.2.6 Operation enabled

Features
= Power unit is switched on
= Drive function is enabled, set values are processed

= Brakes are released with the first active motion command

Application-specific parameterization

= A43 Switch-off delay X1 enable:
If the enable signal at terminal X1 of a safety relay is affected by OSSD test pulses, the drive controller cannot
differentiate these signals from a functional enable-off. An incorrect interpretation of the test pulses can be avoided by
defining a delay time in this parameter that is greater than the duration of the test pulses. This then eliminates
unexpected switching of the drive controller to the states Ready to switch on or Quick stop active (see parameter A44).

= A44 Quick stop at enable off:
This parameter results in a drive being stopped with a quick stop in case of an inactive enable. In this case, the drive
controller switches to the Quick stop active state. If parameter A44 is not activated, the drive switches to the Ready to
switch on state in case of Enable-off. In this case, the drive is brought to an uncontrolled standstill, the power unit is
disabled and axis movement is no longer controlled by the drive controller.

= A29 Quick stop in case of fault
This parameter results in a drive being stopped with a quick stop in case of a fault. In this case, the drive controller
switches to the Quick stop active state. If parameter A29 is not activated, the drive switches to the Fault reaction active
state in the event of a fault. In this case, the drive is brought to an uncontrolled standstill, the power unit is disabled
and axis movement is no longer controlled by the drive controller.

Transition to Quick stop active (7)

Request for a quick stop

OR

Enable inactive AND quick stop in case of Enable-off active
OR

Request for drive-controlled SS1

OR

Request for drive-controlled SS2

Transition to Ready to switch on (11), priority: ®

Enable inactive AND quick stop in case of Enable-off inactive

Transition to Switch on disabled (12), priority: ® ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.7.2.7 Quick stop active

Features
= Power unit is switched on; drive function is enabled
= A quick stop is executed
= Brakes remain released, brake engages at the end of the quick stop or at standstill

= Brake engaging ends the quick stop

Application-specific parameterization

= A39 Maximum quick stop duration for enable off:
If the drive is stopped with a quick stop in the case of an inactive enable signal (see A44), define the maximum time
after which the power unit is switched off in this parameter.

= A45 Quick stop end:
Define whether a quick stop is ended with a standstill of the drive or by canceling the quick stop request in this

parameter.
= A62 Source /quick stop:

Define how a requested quick stop is triggered in this parameter.
Transition to Operation enabled (8)
No quick stop request
AND
Enable active
AND
Quick stop end
AND
No SS1
AND

No SS2

Transition to Ready to switch on (9), priority: ®
Enable inactive AND quick stop in case of Enable-off inactive
OR

Enable inactive AND quick stop end

Transition to Switch on disabled (10), priority: ® ®
Cause for a switch-on lockout

OR

No SS1 AND no SS2 AND quick stop end

OR

SS1 AND standstill

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.7.2.8 Fault reaction active

Features
= Adrive error has occurred
= Fault reaction is executed depending on the respective fault event

= Brakes are activated depending on the respective fault reaction

Application-specific parameterization
A29 Quick stop in case of fault:

If this parameter is activated, the drive is stopped with a quick stop, if possible, in case of fault; if the parameter is inactive,
the movement of the axis is no longer controlled by the drive controller.

Transition to Fault (15)

Fault reaction finished

6.7.2.9 Fault

Features
= Adrive error has occurred
= The fault reaction is finished
= The power unit as well as drive and activation functions are locked

= Brakes engage

Transition to Switch on disabled (16)

After remedying the fault cause and then acknowledging the fault message, the drive controller automatically switches to
Switch on disabled.
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6.8

Motion commands

The operating modes of the application feature special motion commands that are based on the PLCopen standard and are

supplemented by two manufacturer-specific motion commands (MC_DoNothing and MC_MoveSpeed). Any motion

command — except MC_Stop — can be interrupted during execution. To be able to execute a motion command, the

following requirements must be met:

= Local and jog mode must not be activated

= Adrive controller must not be in the Switch on disabled or Fault device state

0: MC_DoNothing
8: MC_MoveSpeed

4: MC_MoveVelocity

9: MC_TorqueControl

2: MC_MoveRelative

3: MC_MoveAdditive

1: MC_MoveAbsolute

6: MC_Home

Axis moves without end with set velocity Velocity =
(without position control) .
-
L
Axis moves without end with set velocity Position -
(with position control) .
| ]
Axis moves without end with set torque/ Torque/force -
force
Axis moves a relative distance; Position -
set position is relative to the actual position .
at the start of the command
| ]
L]
Axis moves a relative distance; Position -
set position is relative to the set position of .
the previous motion command
| ]
L
Axis moves to an absolute set position Position -
(referencing necessary) .
| ]
-
| ]
Axis is referenced Depending on =

the selected

Velocity, override
Acceleration
Deceleration

Jerk

Velocity, override
Acceleration
Deceleration

Jerk

Torque/force

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk

Velocity, override

= Acceleration

referencing type

Deceleration
Jerk

Torque/force
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11: MC_Halt

5: MC_Stop

12: MC_Gearln

14: MC_GearlInPosition

13: MC_GearOut

Tab. 13: Drive Based Synchronous: Available motion commands

Axis is stopped;

next command can be run before standstill

Axis is brought to a standstill;

next command can be executed after

standstill

Axis moves synchronously with a master;
velocity-based coupling (electronic gearbox)

Axis moves synchronously with a master;
position-based coupling (electronic gearbox)

Axis ends the ongoing synchronous motion
and continues with the last synchronous

velocity (electronic gearbox)

Velocity

Velocity

Position

Position

Position

Deceleration

Jerk

Deceleration

Jerk

Acceleration
Deceleration

Jerk

Position, master position

Velocity override
Acceleration
Deceleration

Jerk

For detailed information on the motion commands, refer to the associated manual (see Further information [» 156]).
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6.9

Continue function

In Drive Based Synchronous type applications, the continue function allows you to resume interrupted motion commands,

for example after a quick stop, the triggering of safety technology or after an event with a fault reaction. Using the continue
function, you can also continue motion commands 2: MC_MoveRelative and 3: MC_MoveAdditive and end with the desired

set position, which would not be possible when restarting using the execute signal.

Cancellation causes that can be continued

= Event with fault reaction

Enable-off

Motion command 5: MC_Stop, 11: MC_Halt

Stop signal
Quick stop signal
SS1, SS2

Jog

Motion commands

0:
1

4
5
6:
8
9

MC_DoNothing

: MC_MoveAbsolute

: MC_MoveRelative

: MC_MoveAdditive

: MC_MoveVelocity
: MC_Stop

MC_Home

: MC_MoveSpeed
: MC_TorqueControl

11: MC_Halt

12: MC_Gearln

13: MC_GearOut

14: MC_GearInPosition

v

Motion continues until the set position is reached; set position is
absolute

Motion continues until the set position is reached; set position is relative
to actual position at the start of the command

Motion continues until the set position is reached; set position is
relative to the set position of the previous motion command

Motion continues without end at set velocity

Motion continues without end at set velocity

Motion continues without end with set torque/force
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Motion block operating mode

In motion block operating mode, the digital inputs, control byte of motion block operating mode or Motion block control
panel can serve as the source for the continue signal (control byte: J01; continue source: J917). The continue signal not only
continues the interrupted motion command, but also the entire motion block chain.

Event with fault reaction v -

Enable-off v -

Motion command - Motion command 5: MC_Stop can be part of a motion block chain

5: MC_Stop

Motion command v Motion command 11: MC_Halt can be part of a motion block chain;

11: MC_Halt continue is only possible with stop signal via control byte (prerequisite:
J06 = 2: Parameter JO1)

Stop signal - Stop signal is operated from the control panel in motion block operating

(1440 = 0: Inactive) mode and is used to stop and end the motion block chain

Quick stop signal v -

(A302 = 0: Inactive)

SS1 v -

SS2 v -

Jog (1443 = 1: Active) - -

Motion block reset

You can use the continue function to continue an interrupted motion block if both the motion command and the cause of
cancellation can be continued. If it is not possible to resume the motion block or you do not want to continue the
interrupted motion block, it always has to be deleted from the continue memory by means of a reset before a new motion

block can be started using the execute signal.
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6.10 Electronic nameplate

STOBER synchronous servo motors are generally equipped with EnDat encoders that provide a special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and electronic
values of a motor.

When you operate a drive controller with a STOBER synchronous servo motor and an EnDat encoder, the electronic
nameplate is read and all data transferred if the drive controller is connected online. This specifically includes job data,
current controller values, motor parameters, data on motor temperature sensors, brakes, the commutation offset and the
measured electromotive force. These can be manually optimized later and resaved in the drive controller.

Every time a drive controller is restarted, it checks whether the projected motor, the brake (if applicable), the motor
temperature sensor or commutation have been changed. If so, the changed data is read out. The optimizations saved in the
drive controller are maintained whenever possible.

The automatic read-out of the electronic nameplate is activated at the factory (B04 Electronic nameplate = 64: Active).

6.11 Lag monitoring

In Drive Based Synchronous type applications, you can monitor the lag of the axis with active position control in order to
detect increasing position deviations at an early stage. Monitoring the lag allows you to react quickly before material
damage can occur, e.g. in the event of stiffness or a mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2_,, of the control is
determined and compared with the maximum permissible lag (actual position: I80; set position: 196; permissible lag: 121;
result: 1187). If the permitted lag is exceeded, event 54: Following error is triggered with the corresponding protection level
(protection level: U22).
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7 Appendix

A Standard mapping of Drive Based Synchronous

Information

For fieldbus communication via PROFINET, the processing of process data in some controllers is WORD-oriented (16 bits). In
Drive Based applications, the standard mapping is pre-assigned appropriately. If changes are made to the standard
mapping, take the parameter data type that you are adding to or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.
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JAN

SB6: Drive Based Synchronous receive process data

The following table shows the standard mapping for the receive process data in the Drive Based and Drive Based
Synchronous applications. For fieldbus communication via PROFINET, the process data mapping is done via parameter A90

— A92. For fieldbus communication via EtherCAT, the process data mapping is done via parameter A225 — A228. If

necessary, the standard mapping can be customized.

10-13
14-17
18-21
22

23-24

BYTE
BYTE
WORD
INT8
INT8
INT32
REAL32
REAL32
REAL32
BYTE
INT16

Device control byte
Control byte command
Control word application
Command

Motion-ID

Position

Velocity 1

Velocity Override
Torque/Force reference
Control byte motion block

Reference motion block

Tab. 14: SB6: receive process data (standard mapping)

11.2

A180
1.J37
1210
1.J40
1.J41
1.J42
1.J43
1.J56
1.G469
Jo1
102

SB6: Drive Based Synchronous transmit process data

The following table shows the standard mapping for the transmit process data in the Drive Based and Drive Based

Synchronous applications. For fieldbus communication via PROFINET, the process data mapping is done via parameter A94

— A96. For fieldbus communication via EtherCAT, the process data mapping is done via parameter A233 — A236. If

necessary, the standard mapping can be customized.

8-11
12-15
16-19
20-21
22

23
24-25
26

BYTE
BYTE
WORD
BYTE
BYTE
WORD
INT32
REAL32
REAL32
WORD
INT8
BYTE
INT16
INT8

Status byte device
Status byte device
Status word 2

Status byte application
Status byte command
Status word application
Current position

Actual speed

Actual torque/force
Status word user-defined
Operating condition
Status byte motion block
Actual motion block

Device control state

Tab. 15: SB6: transmit process data (standard mapping)

E200[0]
E200[1]
E201
11212
1.139
1200
1.180
1.188
E90
A67
E80
1302
1300
E48
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7.2 Further information

The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.

Enter the ID of the documentation in the search field.

e oo o

SB6 drive controller Manual System design, technical data, project 443340
configuration, storage, installation, connection,

commissioning, operation, service, diagnostics

EtherCAT communication — SB6 Manual Electrical installation, data transfer, 443516
commissioning, diagnostics, detailed
information
PROFINET communication — SB6 Manual Electrical installation, data transfer, 443519
commissioning, diagnostics, detailed
information
SR6 safety technology — STO via Manual Technical data, installation, commissioning, 442741
terminals diagnostics, detailed information
SU6 safety technology — STO and Manual Technical data, installation, commissioning, 443258
SS1 via PROFIsafe diagnostics, detailed information
SY6 safety technology — STO and Manual Technical data, installation, commissioning, 442744
SS1 via FSoE diagnostics, detailed information
Motion commands Manual Control and status information, denials and 443349

limitations, motion

156

10/2025 | ID 443501.00


http://www.stoeber.de/en/downloads/

10/2025 | ID 443501.00

STOBER

7 | Appendix

1.3

Abbreviations

Al
ALT
CAN
CB
CiA
CNC
DI
EtherCAT
IGB
LinM
LS
LSB
M
M/F
MEnc
PEnc
PROFINET
RS

S

PLC
VM
ZP

Analog Input

Alternative

Controller Area Network
Controller Based

CAN in Automation
Computerized Numerical Control
Digital Input

Ethernet for Control Automation Technology
Integrated Bus

Linear Motor

Limit Switch

Least Significant Bit

Motor

Torque or force

Motor Encoder

Position Encoder

Process Field Network
Reference Switch

Switch

Programmable Logic Controller
Virtual Master

Zero Pulse
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8 Contact

8.1 Consultation, service and address

We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:

http://www.stoeber.de/en/support

If you need our system support:
Phone: +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone: +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone: +49 7231 582-3000

Our address is:

STOBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12

75177 Pforzheim, Germany

8.2 Your opinion is important to us

We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise

productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our

documentation.

If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:

documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team
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8.3 Close to customers around the world

We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at

+43 7613 7600-0
sales@stoeber.at

STOBER FRANCE
www.stober.fr
+33 478 98 91 80
sales@stober.fr

STOBER ITALY
www.stober.it
+39 02 93909570
sales@stober.it

STOBER KOREA
www.stober.kr
+82 10 5681 6298
sales@stober.kr

STOBER SWITZERLAND
www.stoeber.ch

+41 56 496 96 50
sales@stoeber.ch

STOBER TURKEY
www.stober.com

+90 216 510 2290
sales-turkey@stober.com

STOBER USA
www.stober.com
+1 606 759 5090
sales@stober.com

STOBER CHINA
www.stoeber.cn
+86 512 5320 8850
sales@stoeber.cn

STOBER Germany
www.stoeber.de
+49 7231 582-0
sales@stoeber.de

STOBER JAPAN
www.stober.co.jp
+81-3-5875-7583
sales@stober.co.jp

STOBER SWEDEN
www.stober.com

+46 702 394 675
neil.arstad@stoeber.de

STOBER TAIWAN
www.stober.tw
+886 4 2358 6089
sales@stober.tw

STOBER UK
www.stober.co.uk
+44 1543 458 858
sales@stober.co.uk
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Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Control cascade

Complete model of the control structure with the position controller, velocity controller and current controller

components.

Electronic nameplate

The synchronous servo motors are generally equipped with absolute encoders that provide special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and
electronic values of a motor. When you operate a drive controller with a synchronous servo motor and an absolute
encoder, the electronic nameplate is read and all motor data transferred if the drive controller is connected online. The

drive controller automatically determines the associated limit values and control parameters from this data.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as

the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

PID controller

Universal controller type with a P-, I- and D-share. These three adjustment parameters make the controller flexible and
ensure exact and highly dynamic control. However, by implication, it also necessitates a wide variety of variants. It is
that much more important to ensure careful construction that is well-coordinated to the system. The application areas
for this controller type are control circuits with systems of the second order and higher, which must be stabilized

quickly and do not allow for any permanent control deviation.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.
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